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1 Start Here 

In This Chapter 

 About the RadioLinx Industrial Hotspot .................................... 7 

 Package Contents.................................................................... 9 

 System Requirements............................................................ 10 

 Installing the IH Browser Configuration Tool .......................... 10 

 Planning the Network ............................................................. 11 

 Configuring the Radios........................................................... 12 

 Verify Communication ............................................................ 22 

For most applications, the installation and configuration steps described in the 
following topics will work without additional programming. ProSoft Technology 
strongly recommends that you complete the steps in this chapter before 
developing a custom application.  
 

1.1 About the RadioLinx Industrial Hotspot 

The RadioLinx Industrial Hotspot (RLX-IHW) provides high speed industrial 
wireless Ethernet communications between Ethernet devices such as PLCs, I/O, 
and operator interfaces while serving as a repeater/bridge for other hotspots, and 
an access point for wireless clients such as laptops and PDAs.  

1.1.1 Features and Benefits 

Conforms to IEEE 802.11a/b/g  
 Open standard protects wireless network investment  
 High speed (54 Mbps), low latency communications  
 Radio-based IGMP snooping/querying to filter multicast industrial Ethernet 

maximizing bandwidth  
Rugged and Powerful  
 Metal enclosure, industrial operating temperatures, vibration and shock 

resistant 
 Certification Pending for use in hazardous locations (UL1604 Class 1 Div 2, 

ATEX Zone 2)  
 Transmit power and radio frequencies programmable for use globally 
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Data and Network Security  
 Cryptographic strength security with WPA/802.11i-128/192/256 bit AES 

encryption and CCM integrity check  
 Limit access to approved device MAC IDs  
 Monitors RF environment for approved/rogue radios 

Flexible and Reliable  
 Single radio operates as an access point and repeater/bridge and client 
 Automatic network configuration (can be prioritized or fixed) with self-healing 

network and master redundancy for reliable large networks (e.g., SCADA)  
Easy to Configure and Monitor  
 Built-in web server for browser-based configuration and remote diagnostics  
 Included OPC Server for HMI-based RF network diagnostics 

Backed by ProSoft Technology  
 Industrial data communications experts who understand your protocols, 

devices, and applications  
 Indoor/outdoor radio network design assistance – accessory selection, path 

studies, and site survey  
 Three year standard warranty 

1.1.2 Specifications 
Radio 
Frequency Band  
(Varies by country) 

802.11b/g: 
2.412 to 2.462 GHz (FCC)  
2.412 to 2.472 GHz (ETSI) 
802.11a: 
5.150 to 5.250 GHz (FCC/ETSI) 
5.725 to 5.850 GHz (FCC) 

Wireless Standards 802.11a, 802.11b, 802.11g, 802.11i 
Transmit Power  (Programmable)  Up to 50 mW without amplifier 

Up to 500 mW with optional amplifier  
Channel data rates  (Modulation) 802.11b: 11, 5.5, 2, 1 Mbps 

(DSSS - BPSK, QPSK, CCK)  
802.11g: 54, 48, 36, 24, 18, 12, 9, 6 Mbps (OFDM)  
802.11a: 54, 48, 36, 24, 18, 12, 9, 6 Mbps (OFDM) 

Receiver Sensitivity (Typical) –95 dBm @ 1 Mbps 
–90 dBm @ 11 Mbps  
–82 dBm @ 24 Mbps 
–75 dBm @ 54 Mbps  

Channels Selection 1 to 13 (802.11b/g)  
36, 40, 44, 48, 149, 153, 157, 161, 165 (802.11a) 

Security WPA/802.11i with 128/192/256 bit AES-CCM  
Legacy WPA TKIP, WEP support  
MAC ID filter  
Admin password 
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Physical 
Enclosure Extruded aluminum with DIN and panel mount 

Size 101.6 × 63.5 × 56 mm (W × H × D) 

4.0 × 3.5 × 2.2 inches 

Ethernet Ports One 10/100 Base-T connector, shielded RJ45 
IEEE 802.3, 802.3u, 802.3x 

Antenna Ports (2) RP-SMA connectors 

Weight 1.15 lbs (522g) 

Environmental 
Operating Temperature –30° C to +65° C 

Humidity To 90% RH, non-condensing 

External Power 10 to 24 VDC 

Average Power <6W 
 
 

1.2 Package Contents 

Your new RadioLinx Industrial Hotspot radio includes the following components: 

RLX-IHW Industrial 
Hotspot

AC Power Adapter

5-foot Ethernet 
Straight-Thru Cable 
(Gray)

5-foot Ethernet 
Crossover Cable 
(Red)

2 dBi Omni-
directional antenna
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1.3 System Requirements 

The RadioLinx IH Browser configuration tool is designed for Microsoft Windows 
XP, 2000 and 2003. Minimum hardware requirements are: 
 Pentium® II 450 MHz minimum. Pentium III 733 MHz (or better) 

recommended  
 Supported operating systems: 
o Microsoft Windows XP Professional with Service Pack 1 or 2  
o Microsoft Windows 2000 Professional with Service Pack 1, 2, or 3 
o Microsoft Windows Server 2003  
o Microsoft Windows Vista 

 128 Mbytes of RAM minimum, 256 Mbytes of RAM recommended  
 CD-ROM drive 
 100 MB available hard drive space 
 Available RS-232 serial port and null modem cable 
 256-color VGA graphics adapter, 800 x 600 minimum resolution (True Color 

1024 x 768 recommended)  
 Ethernet hub with standard RJ45 Ethernet cable 

or 

Ethernet port with RJ45 crossover cable for direct connection to module 

 A web browser, for example Microsoft Internet Explorer or Firefox.  
In addition, you will need 
 A connection to an existing wired or wireless Ethernet network, with a Static 

or Dynamic IP address for your computer  
 Static IP address, Subnet Mask and Gateway address for each RadioLinx 

device you plan to install. Obtain this information from your system 
administrator 

 

1.4 Installing the IH Browser Configuration Tool 

 To install the IH Browser application: 
1 Insert the ProSoft Solutions CD in your CD-ROM drive. On most computers, 

a menu screen will open automatically. If you do not see a menu within a few 
seconds, follow these steps: 
a Click the Start button, and then choose Run. 
b In the Run dialog box, click the Browse button. 
c In the Browse dialog box, click "My Computer". In the list of drives, 

choose the CD-ROM drive where you inserted the ProSoft Solutions CD. 
d Select the file prosoft.exe, and then click Open. 
e On the Run dialog box, click OK. 
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2 On the CD-ROM menu, click Setup Software.  

 
3 Follow the instructions on the installation wizard to install the program with its 

default location and settings. 
When the installation finishes, you may be prompted to restart your computer if 
certain files were in use during installation. The updated files will be installed 
during the restart process. 

1.5 Planning the Network 

Before you configure and install the network, you should create a plan for it. The 
following points assume that you are creating a bridge network of masters and 
repeaters, but you can also set up clients to work with devices on existing 
wireless LANs. For information, see Set Up a Client. 

To begin, determine where you need radios and then choose locations for them 
accordingly. For example, you might decide to install your master radio near a 
PC in a central plant location. (You can use the PC to configure the radios 
through the Radio Configuration / Diagnostic Utility.) If the plant is an oil refinery, 
for example, you might decide to install radios near the oil tanks. 

The next important issue is how to link the radios. Unless the radios are very 
close together, you must make sure that each pair of radio antennas in the 
network has a line of sight between them. In other words, you must be able to 
see from one antenna to another, either with the naked eye or binoculars. 

If a line of sight does not exist between antennas, you must choose a site for 
installing a repeater radio, which will create a bridge between the radio antennas. 
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Choose the appropriate antennas for the network. If an antenna will be 
connected to the radio by a long cable, you might need to purchase a power 
amplifier, which is available from ProSoft Technology. The more distance 
between an antenna and its radio, the more signal loss the radio will have. For 
more information, see Antennas. 

Consider drawing up your network plans on paper. As part of the drawing, you 
should assign a logical name to each radio. You can use these names later when 
configuring the radios in the Radio Configuration / Diagnostic Utility. 

As part of your planning, you might want to conduct a site survey. ProSoft 
Technology can perform this survey, you can do it yourself, or you can hire a 
surveyor. 

Protect radios from direct exposure to weather, and provide an adequate, stable 
power source. Make sure that your plan complies with the radio's power 
requirements (page 86) and cable specifications (page 87). 

Important: Radios and antennas must be located at least 8 inches (20 cm) away from 
personnel. 

1.5.1 Installation Questions 

Answer the following questions to make your installation easier, and to familiarize 
yourself with your system and what you want to do. 
 
How many radios in your network? 

 
 

 
Master ID     

 
 

 
Repeater ID  

 
 

 
Client ID 

 

 
Locations    

 
 

 

 
Is there a Line of Sight between them? 

 
 

 
Selected the appropriate antennas for your network? 

 
 

 

1.6 Configuring the Radios 

To configure the network radios, follow these steps.  

Use the RLX-IH Browser to display all radios on the network, and then use a 
Web browser or SNMP manager to view and change radio settings. The radio 
package includes the program CD, power supply, Ethernet cable, and a small 
antenna. You must install the antenna later, but it is not needed to get started. 

IMPORTANT: If possible, you should configure all the radios side by side in an office 
setting and make sure they link before you try to install them in the field. 
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 To configure the radios in a network: 
1 Start the IH Browser (page 14) configuration application.  

The PC or laptop must have a wired or wireless Ethernet connection 
configured with a static or dynamic IP address. 

2 Plug in the power cable and Ethernet cable (page 15) to the RLX-IHW radio, 
wait a moment for the radio to power up, and then examine the radio's LED 
display to make sure the radio is working properly. 

3 Assign a temporary IP address: (page 16, page 65) Double-click the radio 
listing in the RLX-IH Browser. In the next window, click OK to accept the 
temporary IP address, subnet mask, and default gateway. 

4 Double-click the radio listing again in the RLX-IH Browser to open the Radio 
Configuration / Diagnostic Utility in your web browser. Enter "password" 
(lower case, no quotes) in the next window and then click Login. 
If necessary, you can enter your own password later. For information, see 
Change Password (page 54). 

5 Set up the master radio first, using the Radio Settings window in the Radio 
Configuration / Diagnostic Utility. 

6 Click Apply Changes to save the master radio settings. 
To cancel the settings and start over, click the Cancel Changes button before 
you click Apply Changes. After they are configured, master radios are 
preceded by an "M" in the utility window list. 

Note: The text shown in yellow at the bottom of the window indicates the status of 
changes you have made to the configuration.  
 If the text shows "Changes not saved", click Apply Changes to save your settings. 
 If the text shows "Changes not saved; Will disrupt X s", you can click Apply 

Changes, however the network will be disrupted temporarily while the changes are 
applied. The value of "X" indicates the number of seconds the network will be 
offline.  

7 Unplug the Ethernet cable from the radio and plug it into the next radio to be 
configured. 

8 Set Up a Repeater. Return to the RLX-IH Browser. To be sure that you are 
seeing the latest status of the radio(s), go to the toolbar (page 74) and click 
the "Clear" icon (eraser) followed by the "Scan" icon (binoculars). Double-
click the listing of the next radio to be configured, and configure it as a 
repeater radio. 

9 Save the Radio Configuration. (page 20) Save the repeater radio settings by 
clicking Apply Changes at the bottom of the Radio Settings screen. Repeat 
steps 7 through 9 to configure each repeater in the network. 

10 After configuring the network and its radios, physically label each radio. 
Labeling eliminates confusion about which radios correspond with which 
radio configurations in the software. You should identify the radio's name, 
network SSID, and IP address, if set. 

11 Install the radios and antennas (page 23). 
The remainder of the topics in this section describe each of these steps in more 
detail. 
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1.6.1 Start IH-Browser 

 To start IH Browser 
1 Click the Start button, and then choose Programs. 
2 In the Program menu, navigate to ProSoft Technology. 
3 In the ProSoft Technology menu, navigate to RadioLinx. 
4 Click RadioLinx IH Browser. 

 

The window lists all the radios your computer can access. The MAC ID number is 
essentially the serial number of the radio; this number is also printed on the side 
of the radio. If a radio listing does not appear in the window, select Scan from the 
File menu. If you still do not see a radio listing, see Troubleshooting. 
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1.6.2 Plug In the Cables 

You can configure the RLX-IHW using the Ethernet port on the radio. On the 
underside are three ports; Ethernet, Serial and Power (10 to 24 VDC 6 W). 

 

From left to right: Ethernet port, serial port and power connector. 
 If you are connecting to the radio through an Ethernet hub or switch, use the 

gray (straight-through) cable. 
 If you are connecting to the radio directly from your PC without going through 

an Ethernet hub or switch, you must use the red (crossover) cable.  

Note: After you plug in the power cable and Ethernet cable, the radio performs a 
startup procedure that includes a self-test, loading the main program, and initializing 
the radio. This startup procedure can take up to two minutes. 

After the startup procedure has completed successfully, the Power/Status LED 
should be green, meaning that the radio has power. The Ethernet LED should 
also be green, meaning that the Ethernet connection is working. The RF 
Transmit and RF Receive LEDs should blink. 

For information on making connections, see Radio power requirements (page 86) 
and Cable specifications (page 87).  
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1.6.3 Detecting the Radio 

After the radio has completed its startup procedure, the radio will appear in the IH 
Browser window.  

 

Tip: If a radio listing does not appear in the window, open the File menu and choose 
Scan. If you still do not see a radio listing, refer to Diagnostics and troubleshooting. 

The next step is to assign a temporary IP address to the radio, so that you can 
configure the radio through its web interface.  

1.6.4 Assign a Temporary IP Address 

You need the IP address to log into the Radio Configuration/Diagnostic Utility 
and configure the radio settings. If the radio is connected to a network with a 
DHCP server, the radio may already have an IP address assigned to it.  

If a DHCP server is not available, or if you prefer to assign a static IP address, 
you can enter a temporary IP here. You will use the Radio Configuration / 
Diagnostic Utility (page 29) to assign a permanent IP address.  

 To assign a temporary IP Address 
1 In IH Browser, click to select the radio.  

Tip: If a radio listing does not appear in the window, open the File menu and choose 
Scan. If you still do not see a radio listing, refer to Diagnostics and troubleshooting. 
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2 Open the Operations menu, and choose Assign IP. This action opens the 
Assign Temporary IP Address dialog box. 

 

3 Accept the dynamically assigned address, and then click OK.  
For information, see Radio Access settings (page 52). 

1.6.5 Set Up the Master Radio 

To configure the radio, double click on the radio (Radio1) in the IH Browser 
window. This action opens a web browser (for example Microsoft Internet 
Explorer or Firefox) and loads the IH Radio's web configuration interface.  
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Important: The radio configuration is protected by a login password. The default 
password for the radio is "password" (lower case, no quotes). To prevent unauthorized 
access to the radio configuration, you should change the password when you have 
finished the initial configuration.  
Note: The master is the "root" or top-level radio in a network. You must have at least 
one master radio per network. For redundancy, you can assign more than one master 
to a network. 

 

To configure a Master radio, make the following changes to the web 
configuration form: 

 Radio Network Settings 
 Radio Name: Enter a unique name for the radio.  
 Select Master as the radio mode. 
 Network SSID: Assign a network name (SSID) of up to 32 characters. The 

radio uses this name in all network references. All radios in a network must 
have the same SSID. 

 Channel: Select a channel and frequency range for the network or accept the 
default value. Network channels allow radios to avoid sharing a frequency 
with other networks in the same location. The channel list indicates the 
channel number as well as the frequency (2.4 gHz or 5 gHz). 
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Important: The RadioLinx IHW radio is supplied with a dual-band antenna that 
supports both frequency ranges. If you use a different antenna with the IHW radio, you 
must choose a channel and frequency range supported by the antenna.  

 Security Settings 
 Encryption Type: Encryption scrambles data so that only intended viewers 

can decipher and understand it. Although "none" is an available encryption 
type, ProSoft Technology strongly recommends encrypting all data sent and 
received from every radio on your network, to help prevent your data from 
being intercepted and decoded.  

 WPA phrase: To use WPA encryption on packets sent between the radios, 
select WPA in the Encryption Type field. Next, in the WPA phrase field, enter 
a pass phrase of between eight and 63 normal keyboard characters. This 
phrase automatically generates an encryption key of 128 hexadecimal 
characters. The default pass phrase is "passphrase" (lower case, no quotes). 
For more information on encryption, see Security settings. 

Because you must assign the same Network SSID and WPA phrase to the 
repeater radios later in this procedure, you should write down the settings.  

Note: Network SSID and WPA phrase are both case-sensitive. 

Network SSID:_________________ 

WPA phrase:__________________ 

 Radio Access Settings 

 
If a DHCP (Dynamic Host Control Protocol) server is configured on your local 
area network, the DHCP server can assign IP addresses automatically.  

If you prefer to assign a Static (Fixed) IP address, select "Use the following IP 
address", and then enter the IP Address, Subnet Mask and Default Gateway in 
the Radio Access Settings area of the IH Radio web configuration form.  

Important: If you intend to assign IP addresses manually, you must not duplicate an 
IP address that is already in use on your network. If you are not sure what IP 
addresses are available, ask your network administrator for assistance.  
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1.6.6 Save the Radio Configuration 

Before closing the Radio Configuration window, you must apply your changes. 
Click Apply Changes to save your configuration and restart the radio.  

Note: To discard your changes and start over, click Cancel Changes.  

 

1.6.7 Set Up a Repeater 

To configure a radio as a Repeater, make the following changes to the web 
configuration form: 

 

 Radio Network Settings 
 Radio Name: Enter a unique name for the radio.  
 Select Repeater as the radio mode. 
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 Network SSID: Enter the SSID you configured for the Master radio. All radios 
in a network must have the same SSID. 

 Security Settings 
 Encryption Type: Encryption scrambles data so that only intended viewers 

can decipher and understand it. Choose the same encryption type you 
configured for the Master radio.  

 WPA phrase: Enter the pass phrase you configured for the Master radio.  

Important: The Network SSID and WPA phrase are case sensitive. Use exactly the 
same combination of upper case and lower case letters you entered for the Master 
radio, otherwise the Repeater radio will not be able to connect to the Master radio.  

By default, a repeater connects automatically to the best available parent radio 
on the network. If necessary, however, you can click the Parent Link button and 
specify how repeater radios connect to the network. See Parent Link settings for 
information. 

1.6.8 Set Up a Client 

Client mode is a special mode in the radio that allows a user to connect an 
Ethernet device to a wireless network through any 802.11a, b or g access point. 
Any Ethernet device that has an RJ45 Ethernet port can, in effect, be 
transformed into an 802.11a, b or g wireless client by attaching the radio. Only a 
single device can be connected to the radio in client mode. Do not connect to 
more than one Ethernet device (using a switch or hub). 

You only use client mode if you need to connect to another brand 802.11a, b or g 
access point. If you are using RLX-IHW radios, you should always use them as 
repeaters (and masters). 

To connect a device to a radio in client mode, click the Client button for the radio 
and try programming the radio's client mode using the Auto setting. To test 
whether the Auto setting will work: 
1 Connect the cable between the device and the radio. 
2 Turn ON the radio power, or cycle the power if the radio is already on. 
3 Turn ON the device. Watch the radio to see if it initializes. The Auto setting 

will work if the device advertises its MAC ID to the radio. 
If the radio's RF LEDs do not show consistent activity after a few minutes, then 
you may need to modify the radio's client settings. Click the Specify radio button, 
determine the MAC ID of the Ethernet device, and type the ID into the Client 
MAC field. 

Client radios are preceded by a 'C' in the list of radios in the RLX-IH Browser. 
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1.7 Verify Communication 

When configured, the name of each radio is preceded by an M (for Master), an R 
(for Repeater), or a C (for Client) in the IH Browser window. 

 

Look at the LEDs to ensure good link quality, as explained in LED display (page 
26). After a repeater is configured, you can unplug the Ethernet cable from it.  
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2 Installing the Radios 

In This Chapter 

 Connecting antennas ............................................................. 24 

If possible, you should configure all the radios side by side in an office setting 
and make sure they link before you install them in the field. If feasible, it would be 
even better if you could set up the entire system in the office and make sure your 
equipment communicates properly through the radio network. 

Tip: To make it easier to physically identify the radios you are configuring, apply a 
label to each radio indicating the radio name and IP address.  

After you have configured each radio using IH Browser and the web configuration 
form, you can install the radios and test their performance. Install the radios in 
their proposed permanent locations, then temporarily place each radio's antenna 
near its proposed mounting location. The temporary placement of the antenna 
can be by hand; however, with this testing method, one person must hold the 
antenna while another monitors the radio's signal strength. 

To see how a radio is linked in the network, make sure that the radio is 
connected to a PC or laptop, and then select Topology View from the View menu 
in the RLX-IH Browser.  

 



RLX-IHW ♦ 802.11a, b, g Installing the Radios 
Industrial Hotspot  

 

Page 24 of 100  ProSoft Technology, Inc. 
September 5, 2007 

 

The Topology view shows a diagram of the network's wireless connections. Use 
this view to see whether all the radios are linked, and that you approve of the 
way the radios are linked. A radio that is not linked to a parent will show as a 
circle outlined by a flashing dashed red line. It may be near the bottom of the 
window, so scroll down to view all available radios. To change how radios link to 
the network, see Parent Link settings. 

Refer to Improve Signal Quality (page 28) for more information on overcoming 
poor connectivity. 
 

2.1 Connecting antennas 

Each radio must have an antenna connected to the Main antenna port on the 
RLX-IHW radio; without an antenna for each radio, the network will not function. 

All antennas for radios that communicate directly with each other should be 
mounted so they have the same antenna polarity. Small antennas with a reverse-
polarity SMA connector can be mounted directly on the radio. Screw the antenna 
onto the antenna port connector until it is snug. 

Larger antennas and antennas that do not have a reverse-gender SMA 
connector must be mounted separately and connected to the radio using a 
coaxial antenna cable. Because the antenna cable attenuates the RF signal, use 
an antenna cable length that is no longer than necessary to ensure optimum 
performance. 
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3 Diagnostics and Troubleshooting 

In This Chapter 

 Check the Ethernet cable....................................................... 26 

 LED display............................................................................ 26 

 Retrieve the default password................................................ 27 

 Troubleshoot RLX-IH Browser error messages...................... 27 

 Troubleshoot missing radios .................................................. 28 

 Improve signal quality ............................................................ 28 

Use the program's diagnostic and signal strength settings at the top of the Radio 
Settings window to make sure the network is working properly. 
 Signal Strength graph: This setting graphically shows the radio's signal 

strength. The graph will show the word Master if a master radio is selected. 
The graph will show the word Scanning if the radio is scanning to find another 
radio to which to connect. If the radio is not connected to a network and not 
currently scanning, the graph will show the words Not connected. 

 Update readings every: If you want to update the diagnostic readings 
according to a particular interval, specify the interval (in seconds) in this field. 

 Read-only fields that appear with the diagnostic settings . 
You can perform the following troubleshooting routines: 
 Check the Ethernet cable 
 Check the serial cable 
 Retrieve the default password 

For more troubleshooting information, go to the ProSoft Technology web site at 
http://www.prosoft-technology.com 

The Radio Configuration / Diagnostic Utility (the web configuration form for the 
radio) provides information that can help you troubleshoot problems with the 
radio. 

Use the program's diagnostic and signal strength settings at the top of the Radio 
Settings window to make sure the network is working properly. 

Signal Strength graph: This setting graphically shows the radio's signal 
strength.  
 The graph will show the word Master if a master radio is selected.  
 The graph will show the word Scanning if the radio is scanning to find 

another radio to which to connect.  
 If the radio is not connected to a network and not currently scanning, the 

graph will show the words Not connected. 

http://www.prosoft-technology.com/
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Update every: If you want to update the diagnostic readings according to a 
particular time interval, specify the interval (in seconds) in this field. After entering 
the new value, press Enter only if you want to save the new value; press Tab or 
click elsewhere to use the new value temporarily. 

The following configuration forms in the Radio Configuration / Diagnostic Utility 
provide information about current radio operation: 
 Address table (page 34) 
 Port status (page 35) 
 Available Parents 

Read-only fields The following topics describe troubleshooting routines: 
 Check the Ethernet cable (page 26) 
 Retrieve the default password (page 27) 
 Troubleshoot RLX-IH Browser error messages (page 27) 
 Troubleshoot missing radios in the RLX-IH Browser (page 28) 

For more troubleshooting information, visit the ProSoft web site at 
http://www.prosoft-technology.com 

3.1 Check the Ethernet cable 

If you connect a radio and the Ethernet LED does not light on the radio, you may 
have used the wrong cable type. In other words, you may have used a cross-
over cable when you should have used a straight-through cable, or vice versa. 

Use a straight-through cable when connecting the radio to an Ethernet hub or a 
10/100 Base-T Ethernet switch. Straight-through cables are used in most cases. 

Use a cross-over cable when connecting the Ethernet radio directly to any device 
that is NOT a switch or a hub (e.g., a direct connection to a PC, PLC, or printer). 

3.2 LED display 

The RLX-IHW front panel includes a set of LEDs that indicate the radio's status: 
LED Description 
Power/Status This green LED indicates that the radio has power. 
RF Transmit This yellow LED indicates RF transmission. 
RF Receive This green LED indicates RF reception. 
Serial If this green LED is lit, the serial cable is connected. If this LED is flashing, a 

serial packet is being transmitted or received. (The serial port is not available 
in the first release of the radio.) 

Ethernet If this green LED is lit, the Ethernet cable is connected. If this LED is flashing, 
an Ethernet packet is being transmitted or received. 

Signal Strength If only one of these three LEDs is lit, then the radio is linked. If two LEDs are 
lit, the radio's signal strength is fair. If all three LEDs are lit, the signal strength 
is good. 

If a radio is configured as a master, the middle light of the three Signal Strength 
LEDs will always be on, and the bottom Signal Strength LED will always be off. 
The top LED on the master will flash if any radios are linked to this master. 

http://www.prosoft-technology.com/
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After you first plug in the power cable and Ethernet cable to the radio, the 
Power/Status LED should be green, meaning that the radio has power. If the 
Ethernet LED is green, then the Ethernet connection is working. The RF Transmit 
and RF Receive LEDs should blink. 

All three LEDs will blink just after the radio links to the Master's signal but before 
it has been fully authenticated. Normally you will see this last only a few seconds. 
If it lasts longer or never turns solid it usually means the encryption keys are not 
correct. 

3.3 Retrieve the default password 

If you forget your password, you will be unable to change the radio settings. You 
can retrieve the default password to use the software again, but you will lose all 
the settings you programmed before. To retrieve the default password and return 
the radio to its factory default settings: 
1 Use a serial cable to connect the radio's serial port to an RS-232 serial port 

on the computer. 
2 Run a terminal program such as HyperTerminal. 
3 Set up the terminal program to communicate directly to the COM port you are 

connecting to by entering the following settings: 
o Baud rate: 38,400 
o Data bits: 8 
o Parity: None 
o Stop bits: 1 
o Flow control: None 

4 Hold down the r (lower case R) key on the keyboard and turn on the radio 
power. Continue holding down the r key for more than 30 seconds until the 
radio initializes.  

5 The radio will be reset to its factory default settings, including the password. 
You should now be able to log in using the default password, which is 
"password". 

3.4 Troubleshoot RLX-IH Browser error messages 

One error message commonly occurs when you use the RLX-IH Browser. You 
can easily remedy this error, which is shown in the following illustration: 
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This error occurs when the RLX-IH Browser attempts to scan for radios and no 
valid network connection exists on the PC, wired or wireless.  

To correct this error, Confirm that your PC has at least one active network (LAN) 
connection; it could be a wired Ethernet connection or a wireless 802.11 
connection. One way to determine if your network connections are active is to 
look in the system tray in the lower-right corner of your desktop. The two-PC icon 
indicates a connection and the icon with a red X indicates an inactive connection. 
If no connections are visible in the system tray, check Network Connections in 
the Control Panel. 

 

Confirm that the network connection has a valid IP address. Your network 
connection might need to have a static IP address assigned to it. Check the IP 
address of your network connection to determine that one has been assigned. 

3.5 Troubleshoot missing radios 

If radios are not visible in the RLX-IH Browser, try the following: 
 First, click the Scan button again. Scans are sent as broadcast messages, 

which can be dropped in RF connections, requiring the user to scan again. 
 Second, make sure that the firewall is not activated on your PC. (This is most 

common in Windows XP). Open the Network connections folder in your 
Windows Control Panel, then open the Local Area Connection Properties 
window and verify that the check box under Internet Connection Firewall is 
not checked. 

 If the preceding approaches do not help, the PC running the RLX-IH Browser 
and the radios are probably not connected to the same local network. Verify 
your connections. 

 If you are in topological view, any unlinked radios may be at the bottom of the 
window. Scroll down to see all radios. If you still cannot see radios with the 
RLX-IH Browser, call technical support.  

 

3.6 Improve signal quality 

If you need to improve a radio's signal quality, try the following steps: 
 Adjust the direction of the high-gain antennas. 
 Increase the height of the antenna's placement. 
 Use higher-gain antennas or external preamplifiers. 
 Select a new location for the radio and/or its antenna. 
 Decrease the length of the antenna cable. 
 Determine and resolve sources of interfering electrical noise. 
 Add a repeater between radios that are not communicating. 
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4 Radio Configuration / Diagnostic Utility 

In This Chapter 

 Radio Status .......................................................................... 31 

 Radio Network settings .......................................................... 37 

 Security settings..................................................................... 48 

 Radio access settings ............................................................ 52 

 Apply Changes....................................................................... 54 

 Cancel Changes..................................................................... 55 

 Factory Defaults ..................................................................... 55 

The RadioLinx Industrial Hotspot radio has a built-in Radio Configuration / 
Diagnostic Utility (radio web configuration form) that allows you to configure the 
radio from any computer that can connect to the radio, through a wired Ethernet 
connection, or through a Wireless (WiFi) connection.  

You can use a web browser such as Microsoft Internet Explorer or Firefox on 
your network-enabled desktop computer, laptop or Personal Data Assistant 
(PDA) to monitor and change the settings within the RadioLinx Industrial Hotspot 
radio.  

 To open the Radio Configuration / Diagnostic Utility 
1 In the RadioLinx Industrial Hotspot Browser, select the radio to configure from 

the list view or topography view, and then click the right mouse button to 
open a shortcut menu.  

2 On the shortcut menu, choose Connect. The Radio Configuration / Diagnostic 
Utility will open in your web browser. 
Or,  
Double-click the selected radio to launch the Radio Configuration / Diagnostic 
Utility. 

You can also open the Radio Configuration / Diagnostic Utility directly from your 
web browser. 

Important: Your desktop computer, laptop, or PDA must be connected to the same 
network as the RadioLinx Industrial Hotspot radio. 

1 Open your web browser. 
2 In the address bar, type "http://", followed by the IP address for the radio, and 

then click the "Go" button. For example, 
http://192.168.6.10 

http://192.168.6.10/
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Read-Only fields 
Some of the fields on the Radio Configuration / Diagnostic Utility form are read-
only, meaning that the content of the field is provided for information only, and 
cannot be directly modified. Notice also that depending on the way the radio is 
configured, some fields and buttons may be unavailable because they do not 
affect the configuration you have selected. Review the topics in this section for 
more information on when and how to use each configuration option.  

Configuration Help 
Help is available for each item in the Radio Configuration / Diagnostic Utility. 
 To view a brief help message about any field on the screen, move your 

mouse pointer over the field, or use the [Tab] key, and refer to the text that 
appears at the bottom of the screen. 

 

 To view more help about the selected field, click the field name. This action 
opens a help page in a new browser window. 
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 To view the complete online documentation for your RadioLinx IH Radio, click 

the  button. This action opens the online documentation in a new 
browser window. Use the Contents, Index and Search tabs in the left frame to 
navigate the help system. 

 
 

4.1 Radio Status 

The following fields appear in the status area at the top of the Radio 
Configuration window.  

 

Use the settings in the Radio Status panel to view the current settings for this 
radio.  
Field Description 
Radio Name The name of the selected radio.  
Radio MAC The MAC address of the selected radio. The MAC ID is also printed on 

the side of the radio. 
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Field Description 
Firmware The version of firmware currently installed. All radios on the network 

must have the same firmware versions installed. For more information 
on firmware versions, refer to Update firmware. 

Update every This value in seconds controls how often the web configuration form 
automatically refreshes. To change the value temporarily, enter the 
new value and press the [Tab] key. To change the value permanently, 
enter the new value and press the [Enter] key. 

Up Time The length of time the radio has operated since the last system power-
up or last system reset. 

Signal Strength Strength of the signal from the Parent radio. 
Parent MAC The MAC address of the parent radio to which the selected radio is 

linked. 
Branch Length The number of RF links from the radio to the master radio. 
# Radios Linked The number of other radios that are linked to this radio. 
Link Time The length of time the radio has been continuously connected to a 

parent radio. 
Available Parents Click this button to view the list of Access Points (Parents) from which 

this radio can detect beacons. This button is only available when the 
radio type is Repeater. 

Address Table Click this button to view a list of MAC addresses for devices entered in 
the radio's address table.  

Port Status Click this button to view spanning tree status of each switch port, for 
RF ports and the RJ45 (Ethernet) port. 

 
 

4.1.1 Available Parents 

This page opens when you click the Available Parents button on the Radio 
Configuration Form.  

Note: This form is not available when the radio type is Master. 

 

This page is helpful for viewing: 
 Possible parents for a repeater. The current parent should normally be the 

radio with the lowest cost and a matching SSID. 
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 Other 802.11 networks in the area. 
 

Field Description 
Only Show Same SSID Select (check) this box to restrict the list of available parents to those 

with the same SSID as the radio you are configuring. 
Refresh Click this button to re-scan the network and update the devices in the 

list. 
Mac ID A unique hexadecimal number that identifies any Ethernet device. 
SSID Network Name (Service Set Identifier). 
Channel The radio channel on which the device is transmitting. The channel 

list indicates the channel number as well as the frequency (2.4 gHz or 
5 gHz). 

Important: The RadioLinx IHW radio is supplied with a 
dual-band antenna that supports both frequency ranges. If 
you use a different antenna with the IHW radio, you must 
choose a channel and frequency range supported by the 
antenna.  

RSSI Received Signal Strength Indication. 
Security The encryption type enabled for the device. 
Speed The IEEE 802.11 connection speed (a, b, or g). The RadioLinx IHW 

radio supports all three 802.11 connection speeds.  
Cost Parent selection cost. 
Age The length of time (in seconds) since the radio last saw a packet from 

this MAC address 
Hops The number of hops to the Master. A value of 0 (zero) is shown for 

non-ProSoft devices. 

This list contains both 802.11 devices that are part of the same SSID as the IHW 
itself (for example, "Minerals") as well as devices that belong to different SSIDs 
(for example, "Network1" and "ProSoftInternal"). This list is updated continuously 
and can be used for many purposes. 

The IH radio updates this list with each 802.11 packet that is received, whether 
from a radio of the same network or one that belongs to another SSID. It can also 
see radios from other vendors. 

Once per second the IH radio evaluates the link it has to its parent to determine if 
this link is the best parent to use. A cost is calculated for each entry and can be 
seen in the column labeled "Cost" in the preceding table. The cost calculation is 
based not only on the strongest signal, but on several other factors to provide 
optimum network communication. 
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4.1.2 Address table 

This configuration page opens when you click the Address Table button on the 
Radio Configuration form.  

 

The Address Table shows the port through which each MAC address is 
connected, along with the age in seconds since the radio last saw a packet from 
this MAC address.  
Field Description 
Radio MAC The MAC address of the selected radio. The MAC ID is also printed 

on the side of the radio. 
Show Addresses for the 
Following 

Use this dropdown list to filter the address list. Options are:  
 Devices Out Ethernet Port 
 Directly Linked Radios/Clients 
 Devices beyond Direct RF Links 

When the table is filtered to show only Directly linked radios/clients, 
an additional RSSI column is listed, showing the Received Signal 
Strength from each radio or client linked to the radio. 

Number of Rows to 
Display 

Use this field to choose how many MAC addresses to display on this 
page. Use the Next and Prev buttons to scroll through the available 
MAC addresses. 

Index Position in the list. Each page shows up to 10 devices. Use the Next 
and Previous buttons to move up and down through the table. 

MAC Address The MAC address for the device.  
Connection The connection type  
Age (s) The length of time (in seconds) since the radio last saw a packet from 

this MAC address 
Top Click the Top button to see the top of the table. The radio will display 

updated data in the table entries.  
Next / Prev If the table has more MAC addresses than it can display in the 

window, use the Next and Prev buttons to move up and down through 
the table.  

Refresh Click Refresh to update the table. 
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4.1.3 Port status 

This configuration page opens when you click the Port Status button on the 
Radio Configuration form.  

 

When you click the Port Status button, you can see information about all the 
active ports on the radio. Above the table, you can see information about the 
current Spanning Tree (page 45), including the MAC address of the "root" device, 
and the timing parameters that are set for the current Spanning Tree. Each radio 
can have up to 34 active ports—one Ethernet cable, one parent RF link, and up 
to 32 child RF links. 

The primary reason for creating a Spanning Tree is that it allows you to create 
fully redundant paths. If any single radio in a redundant path loses its connection, 
another path still exists, and the connection will be updated and communication 
restored.  
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Field Description 
Spanning Tree Protocol: 
Wireless Ports 

The Spanning Tree Protocol level for the wireless port. (Rapid STP or 
STP). 

Ethernet Port The Spanning Tree Protocol level for the Ethernet port. (Rapid STP or 
STP). 

Spanning Tree Root 
MAC 

The MAC ID of the root device in the spanning tree. 

Priority The Spanning Tree device with the lowest-priority value is elected the 
root of the tree 

Max Age The length of time a port can stay enabled without any new spanning 
updates. 

Hello Time The length of time between the transmission of spanning update 
packets. 

Forward Delay The length of time a port must listen for spanning information before 
being activated. 

# Position in the list. Each page shows up to 10 ports. Use the Next and 
Previous buttons to move up and down through the table. 

Connection This field indicates what the port represents: Ethernet, a parent radio, 
or a child radio. 

State The current Spanning Tree state of the port. Possible states are 
Blocking, Learning, Listening, and Forwarding. Forwarding packets 
can be transferred.  

Designation The Spanning Tree designation for the branch off the port. Possible 
designations are Root (ports going to the root), Designated (ports 
going to a branch), or Normal. 

Path Cost The cumulative cost of all wired and wireless links from the port to the 
Spanning Tree root. 

Designated Bridge The next bridge toward the Spanning Tree root for this port. 
Top Click the Top button to see the top of the table.  
Next / Prev If the table has more ports than it can display in the window, use the 

Next and Prev buttons to move up and down through the table.  
Refresh Click Refresh to update the table. 

The following illustration shows the RadioLinx Industrial Hotspot Browser (page 
57) application provided with the radios. Notice it shows the radio named 
Hermatite_4F, linked to Amethyst_BD. This link is shown with a red dotted line. 
Also visible is the level of redundancy in their network. Each of the blue lines 
represents an alternate parent. From this view, you can easily tell how much 
redundancy exists in their network. 
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To display the redundant paths, select the toolbar button denoting two "parents." 
To view the redundancy on a per-radio basis, select the single "parent" button, 
and then click on the radio to view its available redundancies.  

 
 

4.2 Radio Network settings 

The following fields appear in the Radio Network Settings area at the left side of 
the Radio Configuration window.  

 

Use the settings in the Radio Network Settings panel to configure the radios in 
your network. For more information on using these settings, see Configuring the 
radios (page 12). 
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Field Description 
Radio Name Assign a unique name to each radio. 
Network SSID Assign a network name (SSID) of up to 32 characters. The radio uses 

this name in all network references. All radios in a network must have 
the same SSID. SSID names are case-sensitive. 

Master Click this button to configure a radio as a master. The master is the 
root radio in a network. You must have at least one master radio per 
network. For redundancy, you can assign more than one master to a 
network. For information, see Redundancy (page 45). 

Channel list (master 
radio) 

The channel list indicates the channel number as well as the frequency 
(2.4 gHz or 5 gHz). 

Important: The RadioLinx IHW radio is supplied with a dual-
band antenna that supports both frequency ranges. If you 
use a different antenna with the IHW radio, you must choose 
a channel and frequency range supported by the antenna.  

Repeater Click this button to configure a radio as a repeater. The repeater mode 
is the normal radio mode for the network, while the master mode is 
more of a special setting to establish the network channel and define 
the root of the network tree. Repeater radios help extend the range of 
a network and help create the signal "bridges" that allow networked 
radios to communicate. All RLX-IHW radios are capable of repeating. 

Parent Link settings Click this button to specify how a repeater radio connects to the 
network. For information, see Parent Link settings. 

Client This is a special mode that allows you to connect an Ethernet device 
to any 802.11 a, b or g access point. You would only use this mode in 
the special event that you wanted to connect a device to another brand 
access point. For information on setting up a client, see Configuring 
clients. 

Auto / Specify Only choose "specify" if device does not send out any unsolicited 
Ethernet packets. Try Auto first. 

Client MAC The MAC ID of the device connected to the radio, only if the device 
does not advertise its MAC address. 

IGMP Click this button to open the IGMP Settings (page 43) form. Use this 
form to enable (default) or disable IGMP, and to configure how the 
RLX-IHW radio will be have when IGMP is enabled. 

Spanning Tree Click this button to open the Spanning Tree Settings (page 45) form.  
Advanced Config Click this button to open the Advanced Settings form.  
 
 



Radio Configuration / Diagnostic Utility RLX-IHW ♦ 802.11a, b, g 
 Industrial Hotspot 

 

ProSoft Technology, Inc. Page 39 of 100 
September 5, 2007 
 

4.2.1 Parent Link Settings 

This configuration page opens when you click the Parent Link button on the 
Radio Configuration form.  

 

Field Description 
Parent MAC The MAC Address of the radio's Parent node. 
Parent Selection Method 
Automatically Choose 
Best 

The Automatic Parent Selection algorithm uses a calculation to create 
a cost for each possible parent radio that it detects.  
In the calculation the radio includes,  
 RSSI – Stronger signals receive a better cost. 
 Hop Count – Fewer hops from the Master radio is given 

preference and therefore a lower cost 
Choose this setting to allow the radio to determine the best parent to 
select.  

Parent Branch Length With the branch length setting the IH will choose its parent strictly by 
the number of repeaters between it and the Master radio. If Branch 
Length of 1 is chosen, the IH will link only to the Master radio. If 
Branch Length of 2 is chosen, the IH will link only to an IH that is 
linked to the Master radio, and so on. 
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Field Description 
Preferred Parent With the preferred parent setting the IH radio will select its parent from 

a list of possible parents specified by the user. The user can list up to 
eight radios to choose from. 
 Best in List 

When Best in List is selected the IH will select its parent using the 
"Automatic Parent Selection" algorithm, but it will limit the 
selection to the list of radios in the list. Therefore, the radio in the 
list with the lowest cost according to the algorithm will be chosen 
as its parent. 

 Follow List Priority 
When Follow List Priority is chosen the IH will select its parent 
from the list giving preference to the 1st entry followed by the 2nd 
entry and so on. 

Parent Selection Parameters 
Signal Strength 
Threshold 

When the signal from a parent reaches a high enough value, a 
stronger signal will not improve the quality of the link any further. For 
signals that are above that threshold, only fewer hops from the Master 
give preference. You can adjust that threshold here. 

Bands This setting controls which bands a Repeater will scan to look for a 
possible parent. It will scan the 2.4GHz band only, the 5GHz band 
only, or both 2.4GHz and 5GHz bands. 

Rate to Parent The default setting is auto which allows the radio to select the best 
rate to use to the parent radio, and adapt over time. You might specify 
a fixed rate rather than auto for example if the link to the parent has a 
low signal strength in which case fixing a lower rate can improve 
performance. The actual rate used between this radio and its parent is 
the lower value of this setting and the Max Data Rate setting in the 
parent (see Max Data Rate). So use these two controls in conjunction 
if desired to tailor the rate of each parent link. 

Save Saves your changes and updates the radio configuration. 
Cancel Discards your changes without updating the radio configuration. 

When you save a selection and return to the Radio Network Settings panel, 
notice that your selection is indicated under the Parent Link button. 

The Automatic Parent Selection algorithm uses a calculation to create a cost for 
each possible parent radio that it detects. The following graph describes how the 
cost is calculated when the signal strength threshold is set to –60 dBm.  
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Once per second the IHW radio evaluates the link it has to its parent to 
determine if this link is the best parent to use. A cost is calculated for each entry 
and can be seen in the column labeled "Cost" in the preceding table. The cost 
calculation is based not only on the strongest signal, but on several other factors 
to provide optimum network communication. 

Prioritized Parent Selection 

If you need more control than the automatic algorithm allows, you can also define 
a priority list of parents for the IH Radio to choose.  

Prioritized Parent by Branch Length 

 

With Parent Branch Length, the IH will choose its parent strictly by the number 
of repeaters between it and the Master radio. If Branch Length of 1 is chosen, the 
IH will link only to the Master radio. If Branch Length of 2 is chosen, the IH will 
link only to an IH that is linked to the Master radio, and so on. 
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Prioritized Parent by Preferred Parent List 

 

With Preferred Parent, the IH radio will select its parent from a list of possible 
parents that you specify. You can list up to eight radios to choose from. 
 Best in List 

The IH will select its parent using the "Automatic Parent Selection" algorithm 
described above but it will limit the selection to the radios in the list. The radio 
in the list with the lowest cost according to the algorithm will be chosen as its 
parent. 

 Follow List Priority 
The IH will select its parent from the list giving preference to the first entry, 
followed by the second entry, and so on. 
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4.2.2 IGMP Settings 

This configuration page opens when you click the IGMP button on the Radio 
Configuration form.  

 

RLX-IHW radios support IGMP v1 and v2. The default operation of the RLX-IHW 
radios is to have IGMP functionality enabled, although the user can disable IGMP 
entirely. Additionally, the user can specify settings associated with IGMP filtering 
and snooping. Unknown multicast addresses can be sent to all ports (flood) or to 
none (filtered) by changing the IGMP Multicast Filtering option. The user can 
specify whether or not the radio will generate IGMP queries, and configure the 
query interval time. 

By RFC specification, only one device on a network should generate IGMP 
queries. As such, RLX-IHW radios will only send a query if another device has 
not sent a query within its Query Interval setting, even if Query Generation is 
enabled. 
Field Description 
IGMP Multicast Filtering Disabling filtering will cause the radio flood multicast packets to all 

ports. 
Default Propagation 
Action 

Determines how to handle multicast addresses that are not in the 
radio's address table. 

IGMP Query Generation Enables or disables query generation  from this radio. 
IGMP Query Interval Number of seconds between queries (if not pre-emptied by another 

devices queries). 
Multicast State Count Number of queries generated before a device is removed from the 

multicast group on this radio if no response is received. 
Save Saves your changes and updates the radio configuration. 
Cancel Discards your changes without updating the radio configuration. 
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4.2.3 Rapid Spanning Tree Functionality 

The software's built-in Rapid Spanning Tree (RSTP) functionality enables you to 
set up full redundancy between radios or other devices. Spanning Tree shuts off 
ports as necessary to prevent loops. If loops are created in an Ethernet network, 
packets can be circulated endlessly, consuming all the bandwidth and making 
the network unusable. 

RSTP allows users to create truly redundant connections between any two points 
in the network. The radios detect the redundant paths and keep one connection 
alive for communications. If the primary connection fails for any reason, the 
secondary connection is quickly transitioned to a state to forward packets, 
allowing the network to adapt itself to handle problems without customer 
intervention. 

RSTP uses active communications between network devices to propagate 
changes in the network and to cause transitions to occur much more quickly. 
Because RSTP is an IEEE standard, IH radios work in conjunction with wired 
Ethernet switches to form a redundant network. 

Each RSTP device (IH radio or Ethernet switch) communicates with other RSTP 
devices in the network via packets called Bridge Protocol Data Units (BPDUs). 
BPDUs are sent out each of the devices ports. In a wired switch this would be 
from each of the Ethernet ports. In an IH radio, in addition to the Ethernet port, 
each wireless link is considered a port. These BPDUs are the communications 
means to allow each RSTP device in the network to make sure that the proper 
connections still exist. 

In the following illustration, this IH radio has 4 RSTP "ports": 
 Ethernet port (1) 
 A port for its parent connection (2) 
 A port for each of its two child connections (11 and 12). 
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BPDUs are sent out the port at a rate called the "Hello Time". The accepted 
standard value for this is 2 seconds. If a radio (or any other RSTP device) does 
not get a BPDU for 2 Hello Times, it assumes the RSTP device that had been 
there is no longer available. It can then open an alternate path if one is available. 
This process is much like the STP process. If other devices on the network are 
not operating in rapid spanning tree mode, the radio will revert to normal 
spanning tree operation on a per-port basis. 

RSTP provides a performance enhancement over STP operation. By 
comparison, the radio using the STP algorithm would revert its port to the 
listening state, and then to the learning state, before returning to the forwarding 
state. Each of these states takes at least 15 seconds, during which the STP 
devices are listening for BPDUs to re-negotiate the network topology. The 
advantage of using the RSTP functionality is that is uses active handshaking 
between adjacent RSTP devices to re-negotiate the network topology. This 
process takes one to two seconds. 

Each IH radio contains a switch table, which tells it how to forward Ethernet 
packets to get them to their proper destination. When the network topology 
changes, the IH radio flushes its Ethernet switch table immediately. This allows it 
to pass traffic immediately over the new network topology and learn the 
configuration in the process. Until the learning is complete, the packets are 
broadcast to their destination. As each packet is seen and the switch table 
rebuilds, the radios return to directing packets to their destinations. 

4.2.4 Spanning Tree Settings 

This configuration page opens when you click the Spanning Tree button on the 
Radio Configuration form.  
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Field Description 
Enable Spanning Tree Spanning Tree is enabled when this box is checked. Without 

spanning tree, redundant connections might exist if multiple radio 
links are created in parallel with each other. Redundant connections 
are blocked only if spanning tree is enabled. Additionally, spanning 
tree is used to flush the Ethernet switch table when the network 
topology changes as described in the section on Automatic Parent 
Selection. Firmware versions 2.5xx and above for RLX-IH, and all 
versions of RLX-IHW also support Rapid Spanning Tree (RSTP), and 
will default to this mode when enabled.  
The recommended setting for spanning tree is "Enabled".  

Ethernet Edge Port Because RSTP is an active protocol, it depends on communication 
between RSTP devices. If no RSTP device is connected to the 
radio's Ethernet port, the handshake cannot take place. In this case 
RSTP reverts to STP. This means that the Ethernet port will be forced 
to adhere to the timer based transition protocol of STP.  
Therefore on network transitions and power up, communications will 
not be allowed over the Ethernet port for 30 to 45 seconds. This 
setting is an indication that no redundant connections exist out this 
port and communication can immediately be allowed. If for some 
reason a BPDU is received on this port, the RSTP protocol will 
negotiate properly and handle any possible redundant paths.  
The recommended setting for Ethernet Edge Port is "Enabled".  

Bridge Times The values in this list configure the timing intervals to use. 
Priority This setting determines who should be the root of the RSTP. The 

RSTP device with the lowest priority becomes the root. The accepted 
standard value for this is 32768. If wired switches exist in the network 
that support RSTP, they should always be allowed to be the root.  
Set this value to 32769 to prevent the radio from being the root over a 
wired switch. Use this setting when a radio is configured to be a 
Master. 
Set this value to 32770 when the radio is configured to be a 
Repeater. In this way, if only IHs exist in the network, the Master 
radio will become the root. 

Hello Time The rate at which BPDUs are sent out. The industry standard is 2 
seconds. 

Max Age Measures the age of the received protocol information recorded for a 
port and ensures that this information is discarded when its age limit 
exceeds the value to the maximum age parameter recorded by the 
switch. The timeout value for this timer is the maximum age 
parameter of the switches. 

Forward Delay Monitors the time spent by a port in the learning and listening states. 
The timeout value is the forward delay parameter of the switches. 

Path Costs The RSTP and STP algorithms use a cost to determine which 
connections should be used. The "spanning tree" is formed by 
determining the least cost paths from any RSTP device back to the 
root.  

Wireless  To give preference to a wired connection, set the Wireless cost to 
200.  

Ethernet To give preference to a wired Ethernet connection, set the Ethernet 
cost to 100.  
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You can define multiple master radios on the same network. Then, if one master 
radio goes down, any radios linked to it can switch over to the other master, so 
the networked radios remain connected and transmitting. In order to be 
redundant, the two masters should typically be on the same segment—in other 
words, they should be wired together into the same switch. These two masters 
can be assigned different channels to increase network bandwidth, but they must 
be assigned the same SSID. 

Also, because all radios are repeaters, you can set up each radio to be able to 
reach a master radio via multiple repeater paths. Then, if a repeater goes down, 
the linked radios can use a different path to get back to a master radio. 

4.2.5 Advanced Settings 

This configuration page opens when you click the Advanced Configuration button 
on the Radio Configuration form.  

 

It is important to allow many industrial protocols to communicate properly over 
the RLX-IHW radios. The standard 802.11 AP operation for transmitting 
broadcast messages is to accumulate them and transmit them only on specific 
time intervals. This allows clients that are in power-save mode to wake up at the 
synchronized time interval and receive the broadcast packets. However, the 
power-save mode is rarely used in industrial networks. Additionally, many 
industrial protocols utilize multicast traffic, which is sent as broadcast messages 
over the wireless network. By enabling immediate broadcasting, these multicast 
messages are not delayed by the wait for the next time interval to occur before 
they can be transmitted. This results in improved network performance. 
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The settings on this form also allow you to configure the transmission rate and 
broadcast mode to optimize this radio's use on an industrial network.  
Field Description 
Max Data Rate The maximum data transmission rate, in megabits per second, for 

this radio. Available settings range from 1 to 54. 
Max Basic Rate In addition to the Data Rate setting which controls generic data traffic, 

the Basic Rate setting adjusts the rate at which control packets such 
as Beacons and Acks are sent at as well as packets that need to go 
to the whole network such as Broadcasts. Because these packets are 
intended for the whole network, the Max Basic Rate setting of the 
Master is advertised to each of the radios in the network through 
Beacons. Each of the radios other than the Master then inherit the 
Max Basic Rate setting of the Master. Therefore the setting only 
needs to be made in the Master radio. The setting in each of the 
other radios is disregarded. 

Immediate Broadcasting Forward multicast traffic immediately, rather than waiting for specific 
time intervals.  

Block General Probe 
Requests 

Do not respond to general probe requests that are not specific to the 
radio's SSID. 

Range The Range setting allows the radios to account for round trip delays. 
The Range settings should be the same in all radios in the network 
and should be at least large enough to account for the length of any 
links. However, increasing the Range beyond what is necessary can 
cause a slight decrease in throughput. 

TX Power This sets the output power of the radio. 
Save Saves your changes and updates the radio configuration. 
Cancel Discards your changes without updating the radio configuration. 
 
 

4.3 Security settings 

The following fields appear in the Security Settings area in the middle of the 
Radio Configuration window.  
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You can assign the following security settings: 
Field Description 
Encryption type WPA-AES is the preferred encryption method. It contains the latest 

updates to the 802.11 standards for best security. However, some 
legacy devices do not yet support these updates. Therefore, you can 
choose combinations of legacy methods. 
Available encryption types are: 
 None (not recommended) 
 WPA-AES – Latest security setting using WPA (pre-shared key) 

authentication and AES encryption. 
 WPA-TKIP – Security setting using WPA (pre-shared key) 

authentication and TKIP encryption. 
 WEP128 – Legacy security setting using a 128-bit key and WEP 

encryption. 
 WEP64 – Legacy security setting using a 64-bit key and WEP 

encryption. 
WPA phrase (page 50) Enter a WPA pass phrase of between eight and 63 normal keyboard 

characters. 
WEP key (page 50) Enter five normal text characters in the WEP key field 
MAC Filter (page 51) Check (select) this field to restrict connections by MAC address. 
Edit Filter Opens the MAC filter (page 51) form, allowing you to specify the MAC 

addresses of devices to allow in the network. 
Hide Network SSID (page 
51) 

Hides the Network SSID (Network Name) from other 802.11 users. 
You can still connect clients to the "hidden" network by typing the 
Network SSID. 

The following topics describe each security setting in more detail. 
 

4.3.1 Encryption type 

The preferred encryption type is WPA (WiFi Protected Access). You should only 
select WEP (wired equivalency protocol) for use with an older client radio that 
only has WEP encryption. For compatibility with clients that do not support WPA, 
you can select WPA+WEP128 (bits) or WPA+WEP64 (bits) as the encryption 
type. Then the older clients can connect to an access point using the WEP 
setting, but new clients will use WPA and the RLX-IHW radios will still use WPA 
among themselves. 

IMPORTANT: If WPA+WEP is selected, some clients using WPA might not be able to 
connect unless you use a WEP key other than number 1, due to limitations in these 
clients. In such cases, you should set a WEP key other than key 1 and set this same 
key in all clients that are using WEP. See WEP key (page 50). 

WEP is the original security protocol used by 802.11 networks, but WPA offers 
better protection against attacks, for several reasons: WPA distances the 
encryption key from the actual data by performing several algorithms to the key 
before generating the encrypted data, it performs dynamic key management by 
changing keys frequently, and it performs message integrity checks to prevent 
forgery and replay. 
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You can also select WEP 128, WEP 64, or None (no encryption) as the 
encryption type, but none of these settings are recommended. 

Note: If an RLX-IHW is set to use WPA+WEP, it will connect to other radios set to 
WPA only or WPA+WEP, but it will not communicate with radios set to WEP only. 
Likewise, an RLX-IHW in client mode with WPA+WEP selected will not connect to an 
access point with WEP only selected. 

4.3.2 WPA phrase 

To use WPA encryption on packets sent between the radios, enter a WPA pass 
phrase of between eight and 63 normal keyboard characters. This phrase 
automatically generates an encryption key of 128 hexadecimal characters. This 
field is only available if you select WPA as the encryption type. 

The default WPA-AES Phrase when a module ships is 'passphrase'. 

4.3.3 WEP key 

A key is a set of hexadecimal (hex) or ASCII characters used to encrypt data. 
This field is only available if you select WEP as the encryption type. Write down 
your WEP encryption key as you create it, because you must enter the same key 
on your client. 

To create a 64-bit WEP key, enter five normal text characters in the WEP key 
field, which converts the characters automatically to 10 hex digits. Alternatively, 
you can enter 10 hex digits (0 to 9, a to f, A to F) directly in the WEP key field. To 
create a 128-bit key, enter 13 normal text characters, which convert to 26 hex 
digits, or enter 26 hex digits (0 to 9, a to f, A to F) directly. 

Note: Clients often support more than one WEP key. Packets received can be 
decrypted using any one of the keys if programmed, but packets are always 
transmitted with the "default" WEP key number. If you set a transmit key number on 
the RLX-IHW, make sure all other radios and clients have this key programmed. To set 
keys other than key 1 on some clients using Windows, you might have to use the 
Advanced settings. 

Programming more than one key on the RLX-IHW requires setting the key 
number to the key you want to program, entering the key, and saving your 
changes. Repeat these steps for each key you want to program, saving after 
each one; finally, change to the desired transmit key number if necessary and 
save again. (If "****" remains in the key field, the previously programmed key will 
not be changed when changes are applied.) 
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4.3.4 MAC filter 

This configuration page opens when you click the Edit Filter button on the Radio 
Configuration form.  

 

Field Description 
Add MAC Enter the MAC address to add. The address will appear in the list 

after you click the Add MAC button.  
Delete Click this button to delete the selected MAC address from the list. 
Address This list contains all the MAC addresses you have added.  
Top Click the Top button to see the top of the list. 
Next / Prev Click the Next and Prev buttons to move up and down through the 

address list.  
Upload File To assign the same list of MAC addresses to several radios 

conveniently, open a text editor such as Notepad.exe. Enter 
addresses in hexadecimal format, one MAC address per line, 
including periods. When you finish, save the document. In the MAC 
Filter window, click Browse to select the text file, then click Upload 
File to upload the list of MAC addresses.  

Browse Click Browse to navigate to a prepared text file of MAC addresses on 
the appropriate drive and folder, and click the Upload File button. 

Save Saves your changes and updates the radio configuration. 
Cancel Discards your changes without updating the radio configuration. 
 
 

4.3.5 Hide Network SSID 

If you want your radio network to be hidden from other 802.11 users, click the 
Hide Network SSID check box in each radio you want hidden. With the SSID 
hidden, your network does not show up when other clients scan for an access 
point. You can still connect clients to the "hidden" network by typing the Network 
SSID. 
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4.4 Radio access settings 

The following fields appear in the Security Settings area on the right side of the 
Radio Configuration window.  

 

In order to configure or diagnose a radio using its built-in Web server or SNMP 
agent, both your computer and the radio must have IP addresses, and these IP 
addresses must be on the same subnetwork. An IP address is only needed so 
you can configure the radio and view its diagnostic settings. Otherwise, the 
address is unnecessary. 
Field Description 
Obtain IP address - 
DHCP 

Select this option to allow the radio to obtain its IP address from a 
DHCP server. 

Use the following IP 
address 

Select this option to specify a Static IP address to the radio. Enter the 
IP address information in the following fields. 

IP Address Enter an IP address that will not interfere with any other devices on 
the network. Request a block of IP addresses you can use from your 
Network Administrator. 

Subnet Mask Enter the Subnet Mask provided by your Network Administrator.  
Default Gateway Enter the Default Gateway address provided by your Network 

Administrator. 
SNMP button Click this button to open the SNMP (Simple Network Management 

Protocol) Agent settings form. Use this form to configure access to 
radio network settings through an SNMP agent.  

Login Password button Click this button to change the Login Password for the radio. The 
default password is "password". You should change this password, 
and keep a record of it in a safe place, to protect the radio from being 
reconfigured by unauthorized users.  

DHCP (Dynamic Host Control Protocol) is a service provided by a server 
(typically a router or a firewall) on a local area network. Devices on a network 
that supports DHCP can request and receive an IP address from the DHCP 
server. RLX-IHW radios support DHCP; by default, they attempt to obtain an IP 
address from a DHCP server.  

If a DHCP server is not available, the radio will not be able to acquire an IP 
address automatically, therefore you must assign an IP address, subnet mask 
and default gateway to the radio so that it can communicate on the network.  
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You can also assign a Static (fixed or permanent) IP address to the radio to 
make it easier to identify and configure the radio. Static IP addresses are 
particularly useful when configuring radios to serve as Access Points, or for 
radios that must be accessible through a firewall.  

A detailed discussion of TCP/IP networking is beyond the scope of this manual. 
Refer to the following Microsoft knowledgebase article for more information: 
http://support.microsoft.com/kb/164015 

4.4.1 SNMP Agent settings 

This configuration page opens when you click the SNMP button on the Radio 
Configuration form.  

 

SNMP is a network management protocol that is often used with TCP/IP and 
Ethernet. As an alternative to using the Radio Configuration / Diagnostic Utility, 
you can change radio settings and view diagnostics in an SNMP manager 
application, if necessary.  
Field Description 
Enable Click this button to enable the following SNMP Agent settings. 
Allow Any Manager Select this option to allow any user to change the radio settings from 

any computer using SNMP. 
Allow IP Select this setting to restrict access to an SNMP manager with a 

particular IP address, then enter the IP address in the Allow IP field. 
Community String Enter a "community string" (essentially a password) that a manager 

must use to access the radio's SNMP agent. 
Permission Select the permission level to assign to this radio. 
Read only An SNMP Agent can view but cannot modify radio settings. 
Read/Write An SNMP Agent can view and modify radio settings. 
Save Saves your changes and updates the radio configuration. 
Cancel Discards your changes without updating the radio configuration. 

The RLX-IHW SNMP agent supports SNMP protocol version 1.4 and 2 MIBs: 

RFC12133-MIB (partial; internet.mgmt.MIB-2.system, .interfaces, .snmp) 

ROMAP-MIB (included on the CD; internet.private.enterprises.romap) 

It also supports a selection of standard SNMP traps, including Cold Start, which 
is sent when the radio initializes. 

http://support.microsoft.com/kb/164015
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4.4.2 Change password 

This configuration page opens when you click the Login Password button on the 
Radio Configuration form.  

 

Field Description 
Old Enter the current password in this field. The default password is 

"password" (lower case, no quotes). This entry must exactly match 
the current password, otherwise the change will be rejected. 

New Enter the new password in this field. Passwords are case sensitive. 
Repeat Confirm the new password in this field. This entry must exactly match 

the password you entered in the "New" field, otherwise the change 
will be rejected.  

Save Saves your changes and updates the radio configuration. 
Cancel Discards your changes without updating the radio configuration. 

You can enter any alphanumeric value between one and 31 characters. The 
password is case-sensitive. 

If you forget your password, you will be unable to change the radio settings. To 
get the default password again, see Troubleshooting. 

4.5 Apply Changes 

Click the Apply Changes button to save your changes after editing radio 
configuration in order for those changes to take effect. When you apply changes, 
the radio will shut down and restart using the new settings. The following 
illustration shows the Radio Configuration / Diagnostic Utility as the radio 
restarts. 
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4.6 Cancel Changes 

Click Cancel Changes to discard any settings you made during this session.  

Note: This button only applies to changes made in the Radio Configuration / 
Diagnostic window. Changes made to individual configuration forms (for example, 
Spanning Tree, Parent Link, and SNMP Agent settings) take effect when you click the 
Save button on each of those forms. 

4.7 Factory Defaults 

Click the Factory Defaults button to reset the radio to the default settings that 
were configured at the factory.  

Important: This action discards all your radio configuration settings.  

You will be prompted to confirm this action before it takes effect.  
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5 RadioLinx Industrial Hotspot Browser 

In This Chapter 

 Primary radio functions .......................................................... 58 

 Review of Windows mouse and keyboard controls ................ 59 

 File Menu ............................................................................... 61 

 Operations Menu.................................................................... 64 

 Dialogs Menu ......................................................................... 67 

 View Menu ............................................................................. 74 

 Help Menu.............................................................................. 80 

The RLX-IH Browser allows you to find any radios connected to your network, 
see some of their basic settings, and change the IP address so you can access 
the radio's Web page. For more information, see Primary radio functions (page 
58). 

When you run the program, the List view (shown in the illustration) appears with 
a list of any radios on the same network as the computer running the RLX-IH 
Browser. If you do not see a radio you expect to see, click the Scan (page 62) 
button in the tool bar or select Scan from the File menu. 

 

The preceding illustration shows the List View. Refer to Topology view to see 
alternate views. 

To clear all the radios from the list, click the Erase button in the tool bar or select 
Clear from the File menu. You can then refresh the list by clicking Scan. 

If you have trouble viewing radios in the RLX-IH Browser, see Troubleshoot 
missing radios (page 28). 
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5.1 Primary radio functions 

You can perform the following primary functions on any radio in the list by right-
clicking the radio name. 

 

Connect (page 64): Log in to the Radio Configuration / Diagnostic Utility to 
configure a radio or check diagnostics. 

Assign IP (page 16, page 65): Assign a temporary IP address to a radio. 

Update Firmware: Update the version of firmware the radio uses. 

Start Ping Session (page 66):  

Wireless Clients (page 68): View a list of client radios  

Ethernet Nodes (page 69): View a list of wired Ethernet nodes connected to the 
network 

Scan List (page 70): View a list of all the radios detected on the network 
(including those from other vendors) 

Port Table (page 71):  

Event Log (page 71):  

Properties (page 72): View the selected radio's properties. 

In addition, there are more options in the File menu. 
 You can print either a list of the radios' properties or a topology view. 
 Change how the RLX-IH Browser scans for radios. 
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5.2 Review of Windows mouse and keyboard controls 

The Microsoft Windows operating system, and most Windows compatible 
applications, including the RLX-IHW, use the computer keyboard and mouse in a 
standard way. This makes it easier for computer users to learn to use new 
applications quickly. 

The computer you use in the field may be a desktop PC or a laptop PC. Desktop 
PCs typically have a keyboard and mouse (pointing device) connected to the 
computer by cables, or sometimes by a wireless link. Laptop PCs have a built-in 
keyboard and often have a built-in pointing device such as a touch pad or a 
trackball. Most laptops also allow you to connect a standard computer mouse if 
you prefer it to the built-in pointing device. 

5.2.1 Tool Tips 

A Tool Tip is a small help window that pops up when you rest the mouse pointer 
over a button, an icon, a menu command, or a part of a window that is "sensitive" 
to the mouse. Tool Tips provide a brief description of the button or icon's 
purpose. 

Many parts of the IH Browser window provide Tool Tips. These can be very 
useful to help you with buttons or commands that you do not use very often. 

5.2.2 Using the Mouse 

As you move the mouse around on your desk, you will see an arrow (or other 
shape) moving around on the computer screen. You use the mouse or pointing 
device to "point" to a menu, a button, or a data item on the screen. In the 
RadioLinx IH Browser, you click and release the mouse buttons (left and right) to 
select a menu item, to push a button on the screen, to select one or more data 
items, or to open a "shortcut" menu. 

Most people will click the left mouse button with the right index finger, and the 
right mouse button with the right middle finger. You can use the Windows Control 
Panel to reverse the operation of the mouse buttons, for instance if you prefer to 
use your left hand to operate the mouse rather than your right hand. In this 
training manual, however, we will refer to the left mouse button and right mouse 
button as if you are using your right hand on the mouse. 

The left and right mouse buttons have different functions in the RadioLinx IH 
Browser. 
 Use the left mouse button to select a menu item, click a button or select one 

or more data items. 
 Use the right mouse button to open a "shortcut" menu with commands that 

are useful for the item or area of the screen where the mouse pointer is 
currently resting. 
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 Some commands require a double-click before the command is recognized. 
"Double-click" means quickly pressing and releasing the left mouse button 
twice. 

Use double-click to: 
 Open a file or run a program on your computer's "desktop" area. 
 Open and close a folder in the RLX-IHW Tree View window. 

 

5.2.3 Using the Keyboard 

Most of the time, you will be using the keyboard to add or edit data items after 
you have selected and opened them with the mouse. As a timesaver, however, 
you can also use the keyboard to do most of the same things you can do with the 
mouse. 

Some useful keyboard shortcuts include: 
 Windows System Key Combinations (page 60) 
 Dialog Box Commands (page 60) 
 Windows Program Key Combinations (page 60) 
 General Keyboard-Only Commands (page 61) 

 

Windows System Key Combinations 
Key Action 
F1 Help 
ALT+TAB Switch between open programs 
ALT+F4 Quit program 
SHIFT+DELETE Delete item permanently 
 
 

Dialog Box Commands 
Key Action 
TAB Move to the next control in the dialog box 
SHIFT+TAB Move to the previous control in the dialog box 
SPACEBAR If the current control is a button, this clicks the button. If the 

current control is a check box, this toggles the check box. If 
the current control is an option, this selects the option. 

ENTER Equivalent to clicking the selected button (the button with the 
outline) 

ESC Equivalent to clicking the Cancel button 
ALT+ underlined letter in dialog 
box item  

Move to the corresponding item 

 
 

Windows Program Key Combinations 
Key Action 
CTRL+C Copy 
CTRL+X Cut 
CTRL+V Paste 
CTRL+Z Undo 
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General Keyboard-Only Commands 
Key Action 
F1 Starts Windows Help 
F10 Activates menu bar options 
SHIFT+F10  Opens a shortcut menu for the selected item (this is the same 

as right-clicking an object 
ALT+DOWN ARROW Opens a dropdown list box 
ALT+TAB Switch to another running program (hold down the ALT key 

and then press the TAB key to view the task-switching 
window) 

ALT+SPACE Displays the main window's System menu (from the System 
menu, you can restore, move, resize, minimize, maximize, or 
close the window) 

ALT+ underlined letter in menu  Opens the menu 
ALT+F4 Closes the current window 
 
 

5.3 File Menu 

The following commands are available on the File menu: 

 

 Scan Setup  (page 62) 
 Scan (page 62) 
 Clear (page 62) 
 Import (page 62) 
 Export (page 63) 
 Freeze (page 63) 
 Print  (page 63) 
 Print Preview (page 63) 
 Print Setup (page 63) 
 Exit (page 63) 
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5.3.1 Scan Setup 

The Scan Setup command allows you to change some settings that govern how 
the RLX-IH Browser scans for radios. In the top field of the Scan Setup dialog 
box, you can adjust how often the program automatically scans for radios. Enter 
a value (in seconds) to have the RLX-IH Browser scan at that rate. 

In the New address/range fields, you can adjust how the program scans for 
radios. By default, the program sends a broadcast message to all the radios at 
the same time, looking for a response. Broadcasts are limited to a local network, 
and will not be passed through a router. If there is a router between the PC 
running the RLX-IH Browser and the radio to be scanned, the IP address of the 
radio or a range of addresses can be added to the scan list. At each interval 
determined by the scan rate, each IP address is individually queried. 

 
 

5.3.2 Scan 

The RLX-IH Browser automatically scans for all active radios on the network at a 
regular interval, but you can use the Scan command in the File menu to look for 
active radios at any time. 

5.3.3 Clear 

This command clears (deletes) all entries from the IH Browser window.  

5.3.4 Import 

This command imports an XML file created by the Export command in the 
RadioLinx IH Browser.  
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5.3.5 Export 

This command creates and saves an XML file containing the current 
configuration and status of all radios discovered by the RadioLinx IH Browser. 
Use this command under the direction of ProSoft Technical Services, for 
troubleshooting purposes.  

5.3.6 Freeze 

Use this command to temporarily stop the display from updating. This command 
is useful for studying network topology and performance without the distraction of 
radios and other devices appearing and disappearing from the screen.  

5.3.7 Print 

Use this command to print the contents of the RadioLinx IH Browser window. 
Depending on the view you selected, you can print either a list of the radios' 
properties, or a topology view. 

5.3.8 Print Preview 

Displays a preview of the contents of the RadioLinx IH Browser window. You can 
use this to adjust the placement of elements so that they do not span page 
boundaries.  

5.3.9 Print Setup 

Displays the standard Window Print Setup dialog box.  

5.3.10 Exit 

Closes RadioLinx IH Browser. 
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5.4 Operations Menu 

The following commands are available on the Operations Menu: 

 

 Connect (page 64) 
 Assign IP (page 16, page 65) 
 Update Firmware (page 65) 
 Start Ping Session (page 66) 

 

5.4.1 Connect 

To connect to the Radio Configuration / Diagnostic Utility and change radio 
settings, double-click the radio listing in the RLX-IH Browser after it has been 
assigned an IP address (either manually or with DHCP). Alternatively, you can 
select the Connect option in the AP Operations menu. Enter your password to 
log in to the radio. 
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5.4.2 Assign IP 

 

If the radio is connected to a network with a DHCP server, the radio may already 
have an IP address assigned to it. If no address appears, double-click the radio 
listing in the RLX-IH Browser or select Assign IP in the AP Operations menu. In 
the next window, click OK to accept the temporary IP address, subnet mask, and 
default gateway. If necessary, you can enter a particular IP address (see Radio 
Access settings (page 52)). After an IP address is assigned, you can configure 
radios through the Radio Configuration / Diagnostic Utility (page 29). 

5.4.3 Update Firmware 

"Firmware" is the program that runs in the RadioLinx Industrial Hotspot that 
allows it to communicate and exchange data between devices, using the radio as 
a network connection. Different versions of the firmware communicate with other 
radios in different ways, and provide different levels of functionality. 

 

In order for your RadioLinx Industrial Hotspot radio to communicate with other 
RLX-IHW devices, all radios on the network must use the same firmware version.  
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 To change the firmware version of the radio: 
1 Start RadioLinx Industrial Hotspot Browser. 
2 Open the Operations menu, and then choose Update Firmware. 
3 Enter the password for the radio. This is the same password you use to log 

into the radio from the Radio Configuration / Diagnostic Utility (page 29). 
4 Click the Browse button to locate the Image File (firmware version) to update. 

Both versions of firmware are available both on the CD that came with in the 
box with the radio, and at our web site at http://www.prosoft-technology.com 

5 Click Update to begin copying the new firmware to the radio. Do not 
disconnect the cable or turn off power to the radio during this operation.  

5.4.4 Start Ping Session 

A Ping Session allows you to run traffic over the radio network between any two 
computers running the IH Browser. With it the user can monitor their network 
over time.  

To start the ping session, enable "Show Ping Stations" on the View menu, and 
then highlight one of the other computers visible in the IH Browser. The session 
then starts automatically and the Ping Results dialog box opens.  

 

This dialog box displays statistics on the minimum, maximum and average 
latency between two points on the network.  

http://www.prosoft-technology.com/
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Ping Options dialog box 

The Ping Options dialog box opens when you click the Show Options button on 
the Ping Results (page 66) dialog box. Use this dialog box to choose ping 
parameters, logging options, and response to other stations.  

 
 

5.5 Dialogs Menu 

The Dialogs menu contains the following commands: 

 

 Wireless Clients (page 68) 
 Ethernet Nodes (page 69) 
 Scan List (page 70) 
 Port Table (page 71) 
 Event Log (page 71) 
 Properties (page 72) 
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5.5.1 Wireless Clients 

This dialog box opens when you open the AP Dialogs menu and choose 
Wireless Clients. 

Use this dialog box to see information about wireless clients attached to the 
radio. 
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5.5.2 Ethernet Nodes 

This dialog box opens when you open the AP Dialogs menu and choose Ethernet 
Nodes.  

Use this dialog box to see information about Ethernet devices attached to the 
radios. The following illustration shows a list of Ethernet devices (by IP address 
and MAC ID) attached to the Ethernet port of Tourmaline_14. In addition to the IP 
and MAC ID it gives an age for each entry, which is the amount of time since a 
packet has been heard from that device. 

 
 



RLX-IHW ♦ 802.11a, b, g RadioLinx Industrial Hotspot Browser 
Industrial Hotspot  

 

Page 70 of 100  ProSoft Technology, Inc. 
September 5, 2007 

 

5.5.3 Scan List 

This dialog box opens when you open the AP Dialogs menu and choose Scan 
List.  

 

The scan list is a list of all the radios that this particular radio "hears" on this 
channel (via beacons) even if it is not linked to it (different SSID or encryption). 
This list shows the same information as the Available Parents list in the Radio 
Configuration / Diagnostic Utility.  

List entries marked with a "*" indicate the entry is an alternate path, which can 
also be seen if the ‘parents’ button is selected in the menu bar (blue lines will link 
the radio to its alternate parents).  

802.11 Access Point Detector 

The IH radio can be used as an installation tool to analyze the 802.11 
environment and provide the user with information on choosing antenna location 
and channel selection. 

By using the table in the radio, you can mount an IH radio with its actual antenna 
and use it to report information on every active 802.11 radio in the area. It will 
report 
 Each 802.11 AP heard including SSID 
 Actual RSSI from each given in dBm 
 Channel of each radio 

Use this information to help choose a channel that is least utilized, or to select 
appropriate antenna types and alignments to minimize interference. 
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5.5.4 Port Table 

This dialog box opens when you open the AP Dialogs menu and choose Port 
Table. 

 

The port table is a list of all the active ports on the radio. This list shows the same 
information as the Port status (page 35) list in the Radio Configuration / 
Diagnostic Utility. Each radio can have up to 34 active ports—one Ethernet 
cable, one parent RF link, and up to 32 child RF links. 

5.5.5 Event Log 

The event log allows you to extract a log from the selected radio. The log shows 
a history of the radio. You can save the event log to a file for troubleshooting 
purposes. 
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Event Filter 

The Event Filter dialog box allows you to include or exclude specific event types 
from the event log.  

 
 

5.5.6 Properties 

This dialog box opens when you select a radio, and then open the AP Dialogs 
menu and choose Properties.  

 
To see additional properties, click the More button. 
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Field Description 
Radio Name The name of the selected radio.  
MAC The physical media access control address for the network interface. 
IP, Mask, and Gateway The radio's IP address, subnet mask, and default gateway. For 

information, see Radio Access settings (page 52). 
IP State Indicates whether a radio's IP address has been set—"Uninit(ialized)" 

or "OK". 
SSID A name that identifies a wireless network. You assign this name when 

you configure the radio. The SSID must be the same for all radios on 
the same network. 

Mode Indicates whether you designated the radio as a master, repeater, or 
client. 

Connection The status of the wireless connection. 
Signal The signal strength, which in this field is a number from 0 to 15. 
Hops The number of wireless connections a radio is from the closest master 

radio. 
Master The MAC address of the selected radio's master radio. 
Associations The number of network elements to which a radio has a wireless 

connection. 
Bridges The number of repeaters to which a radio has a wireless connection. 
Tx and Rx The transmission throughput rate and the received throughput rate. 

Both rates are measured in kilobytes per second (KB/s). 
Software Version and 
Boot Version 

The versions of the radio's firmware and its boot code. 

Image The image type can be Primary or Secondary. 
Compression Indicates whether the radio's firmware images are compressed or not. 

Ethernet The Ethernet connection status, either Attached or Detached. 

Channel The channel that the radio is using, if connected. The channel list 
indicates the channel number as well as the frequency (2.4 gHz or 5 
gHz). 

Important: The RadioLinx IHW radio is supplied with a dual-
band antenna that supports both frequency ranges. If you 
use a different antenna with the IHW radio, you must choose 
a channel and frequency range supported by the antenna.  

Security Indicates the encryption setting on the radio. See Security settings for 
information. 
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5.6 View Menu 

The View menu contains the following commands: 

 

 Tool Bar (page 74) 
 Status Bar (page 74) 
 List View (page 75) 
 Topology View (page 75) 
 Zoom In (page 77) 
 Zoom Out (page 77) 
 Zoom to Fit (page 78) 
 Show Ping Stations (page 78) 
 Show Parents  (page 79) 
 Print Area (page 79) 
 Reset Columns (page 79) 

 

5.6.1 Tool Bar 

 

The Tool Bar near the top of the IH Browser window contains buttons to access 
frequently used commands. Hold the mouse button over each button to view a 
brief "Tool Tip" explaining the button's use.  

5.6.2 Status Bar 

 

The Status Bar at the bottom of the RLX IH Browser displays additional 
information about the currently selected menu command or tool bar button. On 
the right side of the Status Bar, you can see the status of the Caps Lock and 
Num Lock keys on your computer keyboard. Use the corner of the status bar to 
drag and resize the RLX-IH Browser window.  



RadioLinx Industrial Hotspot Browser RLX-IHW ♦ 802.11a, b, g 
 Industrial Hotspot 

 

ProSoft Technology, Inc. Page 75 of 100 
September 5, 2007 
 

5.6.3 List View 

 
List View shows a list of all the connected radios in a grid, arranged similarly to 
data in a spreadsheet. Resize the window or scroll across to see all of the 
available columns. Click between column headers and drag to the left or right to 
resize columns. Click on column headers and drag to the left or right to re-order 
columns. 

Tip: Use the Reset Columns command to restore the column size and order to their 
default values. 

5.6.4 Topology View 
To see how radios are connected together in the network, select Topology View 
from the View menu. The Topology view shows a diagram of the network's 
wireless connections. If a radio does not appear in the view, it is not connected to 
the network. To change the way a radio is linked to the network, connect to it and 
make changes through its Web page. For information on these settings, see 
Parent Link settings. 
In the topology view, you can double-click a radio to log in to the Radio 
Configuration / Diagnostic Utility and change the radio's settings. To view a 
radio's properties, right-click on a radio representation in the topology view and 
then select Properties from the resulting menu. 
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Refer to Topology View key (page 76) for an explanation of the symbols that 
appear in this view. 

Topology View key 

For information on other options that appear when you right-click a radio 
representation, see RLX-IH Browser options (page 57). 

 

 
Master; always shown at the top 

 

 
Radio linked to the network 

 

 
Radio not linked; no parent 

 

An Ethernet connection exists to the radio; does not 
indicate the number of devices on the connection 

 

Wireless clients (PCMCIA cards) are linked to this 
radio; the number of clients linked is indicated by the 
number of boxes 

 

Signal strength; the width of the line is not calibrated 

 

Alternate parents. 
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5.6.5 Zoom In 

 

Use the Zoom In command in Topology View to enlarge the size of the items in 
the RadioLinx IH Browser window.  

5.6.6 Zoom Out 

 

Use the Zoom Out command in Topology View to Topology View to reduce the 
size of the items in the RadioLinx IH-Browser window.  
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5.6.7 Zoom to Fit 

 

Use the Zoom to Fit command in Topology View to change the size of the items 
so that the entire network fits within the RadioLinx IH-Browser window.  

5.6.8 Show Ping Stations 

Ping Stations are other computers running an instance of RadioLinx IH Browser. 
To test latency between points on the network, select a ping station, open the 
Operations menu, and then choose Start Ping Session. 
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5.6.9 Show Parents 

The show parents function allows you to display the possible alternate parents 
for a repeater graphically in the topology view. The link from the repeater to its 
current parent will be shown in red. If the repeater can hear other radios in the 
network, links to those radios will be shown in blue. This gives a graphical 
representation of the number of alternate paths available to a radio should its 
parent link go down. A detailed list of each of the alternates can be seen by right-
clicking and selecting ‘Scan List’. This list, though, shows not only radios in the 
same network but also 802.11 radios on other networks. 

By selecting All, alternate paths for all repeaters in the network will be shown. By 
selecting One, alternate paths will be shown only for the one repeater that is 
currently selected. 

5.6.10 Print Area 

 
Use the Print Area command to show the border around the area of the IH 
Browser window that you can print using the Print command on the File menu. 

5.6.11 Reset Columns 

 

Use the Reset Columns command to restore the column size and order to their 
default values. You will be prompted to confirm this action.  
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5.7 Help Menu 

The Help menu contains the following commands: 

 

 Help Topics (page 80) 
 Help Index 
 About RLX-IH Browser (page 81) 

 

5.7.1 Help Topics 

Most of the information needed to help you use the RadioLinx IH Browser is 
provided in an online help system that is always available whenever you are 
running the application.  

To view the online help, start the RadioLinx IH Browser, open the Help menu, 
and then choose Help Topics. 

The RadioLinx IH Browser Help System 

The RadioLinx IH Browser has an online help system that works like a web 
browser. Each dialog box has its own page in the help system, which explains 
each item on the dialog box. 

To view the online help, open the Help menu and choose Help Topics.  

Many help pages have links that lead you to more information if you need it. 
Links are always underlined. Use your mouse to click the underlined text to 
"follow a link" and open a help page with more information. 

You can use the Search tab to search for words or phrases inside a help file. The 
help system shows you a list of help topics that contain the words you typed in 
the Search field. Click a topic from the list to view the help page. 

You can also use the Index button to see an index of keywords. You can type the 
first few letters of a keyword to jump directly to the part of the index you would 
like to view. Each keyword is linked to one or more help topics. Click a keyword 
to see a list of topics, and then click a topic from the list to view the help page. 
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5.7.2 About RLX-IH Browser 

 

Use this command to view version information about the RadioLinx IH Browser. 
You may be asked to provide this information if you contact ProSoft Technical 
Services. 
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6 Reference 
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6.1 Glossary 
 

Term Definition 
access point (AP):  A generic term for an 802.11 radio that allows other 802.11 radios, 

commonly called clients, to access a wired network. 
ASCII American Standard Code for Information Interchange. A 

communication mode in which each eight-bit byte in a message is sent 
as two ASCII characters. You can use a set of ASCII characters (or 
hexadecimal characters) as a key to encrypt data and ensure its 
secure transmission. 

client On the RLX-IH radio, Client mode is a special mode that allows you to 
connect an Ethernet device to any 802.11 b access point. You would 
only use Client mode in the special event that you wanted to connect a 
device to another brand access point. 

DCE Data communications equipment. A modem, for example.  
DTE Data terminal equipment. A computer or terminal, for example. 
dBi Decibels referenced to an "ideal" isotropic radiator in free space; 

frequently used to express antenna gain. 
dBm Decibels referenced to one milliwatt (mW); an "absolute" unit used to 

measure signal power (transmitted power output or received signal 
strength). 

decibel (dB) A logarithmic measure of the ratio between two signal levels, used to 
express gain (or loss) in a system. 

default gateway The IP address of a network router where data is sent if the IP address 
is unknown. The gateway is the computer that routes the traffic from 
the local area network to other networks such as the Internet. 

encryption A method of scrambling data so that only intended viewers can 
decipher and understand it. 

firmware Embedded software code that directs radio function. 
full-duplex Simultaneous two-way independent transmission in both directions  
half-duplex A circuit designed to transmit in either direction, but not in both 

simultaneously. 
interference Any unwanted signal that has been transmitted at the same frequency 

that the radio was designed to detect. 
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Term Definition 
IP address An identifier for a computer or device in a TCP/IP network. Networks 

using the TCP/IP Protocol route messages based on the IP address of 
the destination. The format of an IP address is a 32-bit numeric 
address written as four numbers separated by periods. Each number 
can be zero to 255. For example, 1.160.10.240 could be an IP 
address. 

key A set of information, from 40 bits to as much as 256 bits, that is used 
as a seed by an encryption algorithm to encrypt data. 

MAC ID A unique hexadecimal number that identifies any Ethernet device. 
master radio The root radio in a network. You must have at least one master radio 

per network. For redundancy, you can assign more than one master to 
a network. 

RADIUS Short for "Remote Access Dial-In User Server," this term describes a 
general method for allowing network access to remote users. RADIUS 
authenticates a user, specifies passwords, and specifies access rights 
to network resources. Originally used for dial-in access to corporate 
networks via modems, RADIUS is now part of the 802.11i standard to 
control user access to wireless networks. 

repeater radio These radios help create the signal "bridges" that allow radios to 
communicate as a network. A bridge is like a switch, sending data on 
to its destination from the transmitting radio. If two radio antennas do 
not have a line of sight between them, you can add a repeater to 
extend the signal range. 

simplex A circuit capable of operating in only one direction. 
subnet mask A mask used to determine what subnet an IP address belongs to. An 

IP address has two components, the network address and the host 
address. For example, consider the IP address 150.215.017.009. 
Assuming this is part of a Class B network, the first two numbers 
(150.215) represent the Class B network address, and the second two 
numbers (017.009) identify a particular host on this network. 

temporal key integrity 
protocol (TKIP) 

The recommended encryption method for RLX-IH radios. TKIP offers 
better protection than WEP against attacks, for several reasons: TKIP 
distances the encryption key from the actual data by performing 
several algorithms to the key before generating the encrypted data, it 
performs dynamic key management by changing the temporal keys 
frequently, and it performs message integrity checks to prevent forgery 
and replay. 

wired equivalency 
protocol (WEP) 

The original security protocol used by 802.11 networks. 

 
 

6.2 Product Overview 

The RLX-IHW is an industrial high-speed Ethernet radio. You can use it in place 
of Ethernet cables to save money, extend range, and make connections that may 
not otherwise be feasible. The radio operates as a wireless Ethernet switch, so 
any data that you can send over a wired network can also be sent over the radio. 
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The RLX-IHW is certified for unlicensed operation in the United States, Canada 
and Europe at 2.4 and 5 GHz. With an output power of a half-watt and approved 
high-gain antennas, the radios can achieve distances of more than 20 miles line-
of-sight between them. You can use multiple repeaters to extend this range to far 
greater distances. An external half-watt amplifier is also approved for installations 
such as towers, where significant antenna cable loss is present. The radio can 
operate at 11Mbps, even over long distances. 

You can develop a highly reliable wireless network by creating redundant (page 
45) wireless paths. Multiple master radios can be installed without any special 
programming or control. Repeater radios can connect to any master at any time; 
if one master goes down, the repeater connects to another. Likewise, if a 
repeater goes down, any repeater that was connected to it can reconnect to a 
different repeater, keeping the network intact. You can create large, self-healing 
tree-like networks in this fashion. Fully redundant paths are possible because the 
Spanning Tree (page 45) protocol in the radios disables and enables paths as 
necessary to avoid Ethernet loops, which would otherwise make your network 
stop functioning. 

In addition to acting as a switch, every master or repeater radio in an RLX-IHW 
wireless network can simultaneously act as an 802.11 a, b or g access point. 
This allows 802.11 WiFi clients to connect and roam between radios for 
monitoring of the wireless network or general network access. The RLX-IHW has 
a special client mode that allows connection of any Ethernet device to any 
existing 802.11 a, b or g access point, regardless of the brand. (An example of 
an 802.11 client is a laptop with a WLAN card.) 

Note: WiFi is a brand name originally issued by the WiFi Alliance, used to describe the 
underlying technology of wireless_local area networks (WLAN) based on the IEEE 
802.11 specifications.  

A high level of security is inherent with AES (Advanced Encryption Standard) 
encryption. You also can choose TKIP, and if necessary add WEP128 or WEP64 
(Wired Equivalent Protocol) encryption in addition to AES or TKIP for clients that 
do not support AES. A simple Media Access Control (MAC) filter table restricts 
the radios or clients that can link to a selected radio according to the MAC IDs 
you enter in the table. 

The radio is designed for industrial applications with a metal enclosure, DIN rail 
mounting, UL1604 Class I Div II safety rating, and shock and vibration tested to 
IEC 60068. 

The RLX-IHW is easy to use. Use the Radio Configuration / Diagnostic Utility, 
which runs in your web browser, to configure the radio; optionally, you can use 
an SNMP manager for configuration. The radio comes with a Windows-based 
utility called RLX-IH Browser that finds all the radios on the network and lists 
information about them. A topology view in the RLX-IH Browser shows how the 
wireless network is linked together at any point in time. You can update firmware 
at any time from anywhere on the network, even over the wireless link or over the 
Internet. 
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ProSoft Technology radios can easily be installed into new or existing systems. 
The software and manuals can be downloaded from the CD or ProSoft 
Technology's web site at http://www.prosoft-technology.com. 

6.3 Radio hardware 

The RLX-IHW radio consists of the following components, as illustrated and 
explained below: 

Two antenna ports (AUX and MAIN) 

LEDs (page 26) that indicate the status of the radio 

Ethernet and serial cable ports (page 87) (Note that the serial port is currently 
only used to reset the login password) 

Power connection (page 86) 

 
 

6.3.1 Radio power requirements 

The RLX-IHW radio accepts voltages between 10 and 24 VDC, with an average 
power draw of less than 6 watts. A detachable power connector comes with the 
radio, as shown. The connector terminals are labeled + (positive DC connection) 
and – (DC ground connection). You can order an optional AC-to-DC power 
supply adapter that is pre-wired with a power connector. The DC power wires 
must be less than 3 m to meet regulatory requirements. 

http://www.prosoft-technology.com/
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Label     Connect to... 

+              10 to 24 VDC 

—             DC Ground 

 
 

6.3.2 Cable specifications 

The recommended cable is category 5 or better. A category 5 cable has four 
twisted pairs of wire that are color-coded and cannot be swapped. The radio 
uses only two pairs. One pair uses pins 1 and 2, and the second pair uses pins 3 
and 6. 

Use a straight-through cable when connecting the radio to an Ethernet hub or a 
10/100 Base-T Ethernet switch. Straight-through cables are used in most cases. 

Use a cross-over cable when connecting the Ethernet radio directly to any device 
that is NOT a switch or a hub (e.g., a direct connection to a PC, PLC, or printer). 

Ethernet cabling is like U.S. telephone cables, except that it has eight 
conductors. Some hubs have one input that can accept either a straight-through 
or crossover cable, depending on the switch position. In this case, you must 
ensure that the switch position and cable type agree. 

Refer to Ethernet cable configuration (page 87) for a diagram of how to configure 
Ethernet cable. 

6.3.3 Ethernet cable configuration 

Note: The standard connector view shown is color-coded for a straight-through cable. 

Crossover cable Straight- through cable 
RJ-45 PIN RJ-45 PIN RJ-45 PIN RJ-45 PIN 

1 Rx+ 3 Tx+ 1 Rx+ 1 Tx+ 

2 Rx- 6 Tx- 2 Rx- 2 Tx- 

3 Tx+ 1 Rx+ 3 Tx+ 3 Rx+ 

6 Tx- 2 Rx- 

 

6 Tx- 6 Rx- 

 
 



RLX-IHW ♦ 802.11a, b, g Reference 
Industrial Hotspot  

 

Page 88 of 100  ProSoft Technology, Inc. 
September 5, 2007 

 

 



ProSoft Technology, Inc., Support, Service & Warranty RLX-IHW ♦ 802.11a, b, g 
 Industrial Hotspot 

 

ProSoft Technology, Inc. Page 89 of 100 
September 5, 2007 
 

7 ProSoft Technology, Inc., Support, Service & 
Warranty 

In This Chapter 

 How to Contact Us: Sales and Support.................................. 90 

 Return Material Authorization (RMA) Policies and Conditions91 

 Procedures for Return of Units Under Warranty..................... 91 

 Procedures for Return of Units Out of Warranty..................... 92 

 LIMITED WARRANTY ........................................................... 93 

Be sure and read the full Warranty that can be found on our web site at 
www.prosoft-technology.com for details and other terms and conditions. The 
content in this summary is subject to change without notice. The content is 
current at date of publication. 

ProSoft Technology, Inc. strives to provide meaningful support to its customers. 
Should any questions or problems arise, please feel free to contact us at: 
Internet Web Site: http://www.prosoft-technology.com/support 

E-mail address: support@prosoft-technology.com 

Those of us at ProSoft Technology, Inc. want to provide the best and quickest 
support possible, so before calling please have the following information 
available. You may wish to fax this information to us prior to calling. 
1 Product Version Number 
2 System architecture 
3 Network details 
In the case of hardware, we will also need the following information: 
1 Module configuration and contents of file 
2 Module Operation 
3 Configuration/Debug status information 
4 LED patterns 
5 Information about the processor and user data files as viewed through the 

development software and LED patterns on the processor 
6 Details about the networked devices interfaced, if any 
For technical support calls within the United States, an after-hours answering 
system allows pager access to one of our qualified technical and/or application 
support engineers at any time to answer your questions. 
 

http://www.prosoft-technology.com/
http://www.prosoft-technology.com/support
mailto:support@prosoft-technology.com
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7.1 How to Contact Us: Sales and Support 

All ProSoft Technology Products are backed with full technical support. Contact 
our worldwide Technical Support team and Customer Service representatives 
directly by phone or email: 
USA / Latin America (excluding Brasil) (Office in California) 
+1(661) 716-5100 
+1(661) 716-5101 (Fax) 
1675 Chester Avenue, 4th Floor 
Bakersfield, California 93301 
U.S.A. 
+1.661.716.5100, support@prosoft-technology.com 
Languages spoken include: English, Spanish 
Asia Pacific (office in Malaysia) 
+603.7724.2080 
+603.7724.2090 (Fax) 
C210, Damansara Intan, 
1 Jalan SS20/27, 47400 Petaling Jaya 
Selangor, Malaysia 
 +603.7724.2080, asiapc@prosoft-technology.com 
Languages spoken include: Chinese, Japanese, English 
China Pacific (office in China) 
+86.21.64518356 x 8011 
+86.21.64756957 (Fax) 
4/F, No. 16 Hongcao Road 
Shanghai, China 200233 
China 
+86.21.64518356 x 8011, zhang@prosoft-technology.com 
Languages spoken include: Chinese, English 
Europe / Middle East / Africa (office in Toulouse, France) 
+33 (0) 5.34.36.87.20 
+33 (0) 5.61.78.40.52 (Fax) 
Zone d'activité de Font Grasse 
17, rue des Briquetiers 
F-31700 Blagnac 
France 
+33 (0) 5.34.36.87.20. support. EMEA@prosoft-technology.com 
Languages spoken include: French, English 
Brasil (office in Sao Paulo) 
+55-11-5084-5178 
+55-11-5083-3776 (Fax) 
Rua Vergueiro, 2949 - sala 182 - Edifício Vergueiro Work Center 
Vila Mariana - São Paulo 
Cep: 04101-300 – Brasil 
+55-11-5084-5178, eduardo@prosoft-technology.com 
Languages spoken include: Portuguese, English 
 

mailto:support@prosoft-technology.com
mailto:asiapc@prosoft-technology.com
mailto:zhang@prosoft-technology.com
mailto:EMEA@prosoft-technology.com
mailto:eduardo@prosoft-technology.com
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7.2 Return Material Authorization (RMA) Policies and Conditions 

The following RMA Policies and Conditions apply to any returned product. These 
RMA Policies are subject to change by ProSoft without notice. For warranty 
information, see Section C below entitled "Limited Warranty". In the event of any 
inconsistency between the RMA Policies and the Warranty, the Warranty shall 
govern. 

7.2.1 All Product Returns 

1 In order to return a Product for repair, exchange or otherwise, the Customer 
must obtain a Returned Material Authorization (RMA) number from ProSoft 
and comply with ProSoft shipping instructions. 

2 In the event that the Customer experiences a problem with the Product for 
any reason, Customer should contact ProSoft Technical Support at one of the 
telephone numbers listed above in Section A. A Technical Support Engineer 
will request several tests in an attempt to isolate the problem. If after these 
tests are completed, the Product is found to be the source of the problem, 
ProSoft will issue an RMA. 

3 All returned Products must be shipped freight prepaid, in the original shipping 
container or equivalent, to the location specified by ProSoft, and be 
accompanied by proof of purchase. The RMA number is to be prominently 
marked on the outside of the shipping box. Customer agrees to insure the 
Product or assume the risk of loss or damage in transit. Products shipped to 
ProSoft without an RMA number will be returned to the Customer, freight 
collect. Contact ProSoft Technical Support for further information. 

4 Out of warranty returns are not allowed on RadioLinx accessories such as 
antennas, cables, and brackets. 

The following policy applies for Non-Warranty Credit Returns: 
A 10% Restocking Fee if Factory Seal is not broken 
B 20% Restocking Fee if Factory Seal is broken 
ProSoft retains the right, in its absolute and sole discretion, to reject any non-
warranty returns for credit if the return is not requested within three (3) months 
after shipment of the Product to Customer, if the Customer fails to comply with 
ProSoft's shipping instructions, or if the Customer fails to return the Product to 
ProSoft within six (6) months after Product was originally shipped. 

7.3 Procedures for Return of Units Under Warranty 

1 A Technical Support Engineer must pre-approve all product returns. 
2 Module is repaired or replaced after a Return Material Authorization Number 

is entered and a replacement order is generated. 
3 Credit for the warranted item is issued within 10 business days after receipt of 

product and evaluation of the defect has been performed by ProSoft. The 
credit will only be issued provided the product is returned with a valid Return 
Material Authorization Number and in accordance with ProSoft's shipping 
instructions. 
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a) If no defect is found, a credit is issued. 
b) If a defect is found and is determined to be customer generated or if the 

defect is otherwise not covered by ProSoft's Warranty, or if the module is 
not repairable, a credit is not issued and payment of the replacement 
module is due. 

 

7.4 Procedures for Return of Units Out of Warranty 

1 Customer sends unit in for evaluation. 
2 If no defect is found, Customer will be charged the equivalent of US $100 

plus shipping, duties and taxes that may apply. A new Purchase Order will be 
required for this evaluation fee. 
If the unit is repaired the charge to the Customer will be 30%* of the list price 
plus any shipping, duties and taxes that may apply. A new Purchase Order 
will be required for a product repair. 

3 For an immediate exchange, a new module may be purchased and sent to 
Customer while repair work is being performed. Credit for purchase of the 
new module will be issued when the new module is returned in accordance 
with ProSoft's shipping instructions and subject to ProSoft's policy on non-
warranty returns. This is in addition to charges for repair of the old module 
and any associated charges to Customer. 

4 If, upon contacting ProSoft Customer Service, the Customer is informed that 
unit is believed to be unrepairable, the Customer may choose to send unit in 
for evaluation to determine if the repair can be made. Customer will pay 
shipping, duties and taxes that may apply. If unit cannot be repaired, the 
Customer may purchase a new unit. 

 

7.4.1 Un-repairable Units 
 3150-All 
 3750 
 3600-All 
 3700 
 3170-All 
 3250 
 1560 can be repaired, if defect is the power supply 
 1550 can be repaired, if defect is the power supply 
 3350 
 3300 
 1500-All 

* 30% of list price is an estimated repair cost only. The actual cost of 
repairs will be determined when the module is received by ProSoft and 
evaluated for needed repairs. 
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Purchasing Warranty Extension 

As detailed below in ProSoft's Warranty, the standard Warranty Period is one 
year (or in the case of RadioLinx modules, three years) from the date of delivery. 
The Warranty Period may be extended for an additional charge, as follows: 
 Additional 1 year = 10% of list price 
 Additional 2 years = 20% of list price 
 Additional 3 years = 30% of list price 

 

7.5 LIMITED WARRANTY 

This Limited Warranty ("Warranty") governs all sales of hardware, software and 
other products (collectively, "Product") manufactured and/or offered for sale by 
ProSoft, and all related services provided by ProSoft, including maintenance, 
repair, warranty exchange, and service programs (collectively, "Services"). By 
purchasing or using the Product or Services, the individual or entity purchasing or 
using the Product or Services ("Customer") agrees to all of the terms and 
provisions (collectively, the "Terms") of this Limited Warranty. All sales of 
software or other intellectual property are, in addition, subject to any license 
agreement accompanying such software or other intellectual property. 

7.5.1 What Is Covered By This Warranty 

A Warranty On New Products: ProSoft warrants, to the original purchaser 
only, that the Product that is the subject of the sale will (1) conform to and 
perform in accordance with published specifications prepared, approved, 
and issued by ProSoft, and (2) will be free from defects in material or 
workmanship; provided these warranties only cover Product that is sold as 
new. This Warranty expires one year (or in the case of RadioLinx 
modules, three years) from the date of shipment (the "Warranty Period"). 
If the Customer discovers within the Warranty Period a failure of the 
Product to conform to specifications, or a defect in material or 
workmanship of the Product, the Customer must promptly notify ProSoft 
by fax, email or telephone. In no event may that notification be received by 
ProSoft later than 15 months (or in the case of RadioLinx modules, 39 
months) from the date of delivery. Within a reasonable time after 
notification, ProSoft will correct any failure of the Product to conform to 
specifications or any defect in material or workmanship of the Product, 
with either new or used replacement parts. Such repair, including both 
parts and labor, will be performed at ProSoft's expense. All warranty 
service will be performed at service centers designated by ProSoft. If 
ProSoft is unable to repair the Product to conform to this Warranty after a 
reasonable number of attempts, ProSoft will provide, at its option, one of 
the following: a replacement product, a full refund of the purchase price or 
a credit in the amount of the purchase price. All replaced product and 
parts become the property of ProSoft. These remedies are the Customer's 
only remedies for breach of warranty. 

B Warranty On Services: Material and labor used by ProSoft to repair a 
verified malfunction or defect are warranted on the terms specified above 
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for new Product, provided said warranty will be for the period remaining on 
the original new equipment warranty or, if the original warranty is no 
longer in effect, for a period of 90 days from the date of repair. 

C The Warranty Period for RadioLinx accessories (such as antennas, 
cables, brackets, etc.) are the same as for RadioLinx modules, that is, 
three years from the date of shipment. 

7.5.2 What Is Not Covered By This Warranty 

A ProSoft makes no representation or warranty, expressed or implied, that 
the operation of software purchased from ProSoft will be uninterrupted or 
error free or that the functions contained in the software will meet or 
satisfy the purchaser's intended use or requirements; the Customer 
assumes complete responsibility for decisions made or actions taken 
based on information obtained using ProSoft software. 

B With the exception of RadioLinx accessories referenced in paragraph 1(c) 
this Warranty does not cover any product, components, or parts not 
manufactured by ProSoft. 

C This Warranty also does not cover the failure of the Product to perform 
specified functions, or any other non-conformance, defects, losses or 
damages caused by or attributable to any of the following: (i) shipping; (ii) 
improper installation or other failure of Customer to adhere to ProSoft's 
specifications or instructions; (iii) unauthorized repair or maintenance; (iv) 
attachments, equipment, options, parts, software, or user-created 
programming (including, but not limited to, programs developed with any 
IEC 61131-3 programming languages, or "C") not furnished by ProSoft; (v) 
use of the Product for purposes other than those for which it was 
designed; (vi) any other abuse, misapplication, neglect or misuse by the 
Customer; (vii) accident, improper testing or causes external to the 
Product such as, but not limited to, exposure to extremes of temperature 
or humidity, power failure or power surges outside of the limits indicated 
on the product specifications; or (viii) disasters such as fire, flood, 
earthquake, wind or lightning. 

D The information in this Agreement is subject to change without notice. 
ProSoft shall not be liable for technical or editorial errors or omissions 
made herein; nor for incidental or consequential damages resulting from 
the furnishing, performance or use of this material. The user guides 
included with your original product purchased by you from ProSoft, 
contains information protected by copyright. No part of the guide may be 
duplicated or reproduced in any form without prior written consent from 
ProSoft. 
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7.5.3 DISCLAIMER REGARDING HIGH RISK ACTIVITIES 

PRODUCT MANUFACTURED OR SUPPLIED BY PROSOFT IS NOT FAULT 
TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR 
USE IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE 
PERFORMANCE (INCLUDING, WITHOUT LIMITATION, THE OPERATION OF 
NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OF COMMUNICATION 
SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES 
OR WEAPONS SYSTEMS), IN WHICH THE FAILURE OF THE PRODUCT 
COULD LEAD DIRECTLY OR INDIRECTLY TO DEATH, PERSONAL INJURY, 
OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE (COLLECTIVELY, 
"HIGH RISK ACTIVITIES"). PROSOFT SPECIFICALLY DISCLAIMS ANY 
EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK 
ACTIVITIES. 

7.5.4 DISCLAIMER OF ALL OTHER WARRANTIES 

THE WARRANTIES SET FORTH IN PARAGRAPH 1 ABOVE ARE IN LIEU OF 
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 

7.5.5 LIMITATION OF REMEDIES** 

IN NO EVENT WILL PROSOFT (OR ITS DEALER) BE LIABLE FOR ANY 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES BASED ON 
BREACH OF WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, STRICT 
TORT, OR ANY OTHER LEGAL THEORY. DAMAGES THAT PROSOFT AND 
ITS DEALER WILL NOT BE RESPONSIBLE FOR INCLUDE, BUT ARE NOT 
LIMITED TO: LOSS OF PROFITS; LOSS OF SAVINGS OR REVENUE; LOSS 
OF USE OF THE PRODUCT OR ANY ASSOCIATED EQUIPMENT; LOSS OF 
DATA; COST OF CAPITAL; COST OF ANY SUBSTITUTE EQUIPMENT, 
FACILITIES, OR SERVICES; DOWNTIME; THE CLAIMS OF THIRD PARTIES, 
INCLUDING CUSTOMERS OF THE PURCHASER; AND INJURY TO 
PROPERTY. 
** Some areas do not allow time limitations on an implied warranty, or allow the exclusion or 
limitation of incidental or consequential damages. In such areas the above limitations may not 
apply. This Warranty gives you specific legal rights, and you may also have other rights which vary 
from place to place. 

7.5.6 Time Limit for Bringing Suit 

Any action for breach of warranty must be commenced within 15 months (or in 
the case of RadioLinx modules, 39 months) following shipment of the Product. 
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7.5.7 No Other Warranties 

Unless modified in writing and signed by both parties, this Warranty is 
understood to be the complete and exclusive agreement between the parties, 
suspending all oral or written prior agreements and all other communications 
between the parties relating to the subject matter of this Warranty, including 
statements made by salesperson. No employee of ProSoft or any other party is 
authorized to make any warranty in addition to those made in this Warranty. The 
Customer is warned, therefore, to check this Warranty carefully to see that it 
correctly reflects those terms that are important to the Customer. 

7.5.8 Intellectual Property 

A Any documentation included with Product purchased from ProSoft is 
protected by copyright and may not be photocopied or reproduced in any 
form without prior written consent from ProSoft. 

B ProSoft's technical specifications and documentation that are included 
with the Product are subject to editing and modification without notice. 

C Transfer of title shall not operate to convey to Customer any right to make, 
or have made, any Product supplied by ProSoft. 

D Customer is granted no right or license to use any software or other 
intellectual property in any manner or for any purpose not expressly 
permitted by any license agreement accompanying such software or other 
intellectual property. 

E Customer agrees that it shall not, and shall not authorize others to, copy 
software provided by ProSoft (except as expressly permitted in any 
license agreement accompanying such software); transfer software to a 
third party separately from the Product; modify, alter, translate, decode, 
decompile, disassemble, reverse-engineer or otherwise attempt to derive 
the source code of the software or create derivative works based on the 
software; export the software or underlying technology in contravention of 
applicable US and international export laws and regulations; or use the 
software other than as authorized in connection with use of Product. 

7.5.9 Additional Restrictions Relating To Software And Other 
Intellectual Property 

In addition to complying with the Terms of this Warranty, Customers purchasing 
software or other intellectual property shall comply with any license agreement 
accompanying such software or other intellectual property. Failure to do so may 
void this Warranty with respect to such software and/or other intellectual 
property. 
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7.5.10 Allocation of risks 

This Warranty allocates the risk of product failure between ProSoft and the 
Customer. This allocation is recognized by both parties and is reflected in the 
price of the goods. The Customer acknowledges that it has read this Warranty, 
understands it, and is bound by its Terms. 

7.5.11 Controlling Law and Severability 

This Warranty shall be governed by and construed in accordance with the laws of 
the United States and the domestic laws of the State of California, without 
reference to its conflicts of law provisions. If for any reason a court of competent 
jurisdiction finds any provisions of this Warranty, or a portion thereof, to be 
unenforceable, that provision shall be enforced to the maximum extent 
permissible and the remainder of this Warranty shall remain in full force and 
effect. Any cause of action with respect to the Product or Services must be 
instituted in a court of competent jurisdiction in the State of California. 
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